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Introduction

G/L Consolidations allows you to perform sophisticated consolidations of multiple general ledgers, 
while maintaining a comprehensive audit trail.

Using G/L Consolidations, you can:

 l Consolidate any number of general ledgers, using single-level and multilevel consolidations.

 l Export transactions by posting sequence, by fiscal period, by net changes, or by balances.

 l Consolidate transactions as often as required (for example, weekly consolidated reports).

 l Consolidate multicurrency and single-currency ledgers with the same or differing functional 
currencies.

 l Consolidate companies with different year-ends.

 l Consolidate dissimilar account code structures, using a mapping table.

 l Merge multiple accounts in subsidiaries into single holding company accounts.

 l Transfer transactions originating in a holding company (or elsewhere) back to subsidiaries. 
(This can be useful where payroll or fixed assets are maintained centrally.)

 l Maintain a full audit trail of transactions, as well as a detailed audit trail of all consolidation 
activities.

 l Consolidate transactions from subsidiaries and holding companies at different locations. G/L 
Consolidations is designed so that data can be extracted and made available for transfer to 
other locations.

 l Import and export optional field setup data to and from General Ledger and Common Services.

 l Import and export account optional fields and transaction optional fields.

Depending on your purchase agreement, some features described in this guide may not be 
available in your product.

The G/L Consolidations User's Guide contains the following chapters:

 l Chapter 1: Key Concepts in G/L Consolidations

Develop a thorough understanding of key concepts in G/L Consolidations, including 
multicurrency considerations, audit trail information, and information about consolidating 
transactions, budgets, and account information.
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 l Chapter 2: Setting Up G/L Consolidations

Set up records and specify options that determine how G/L Consolidations imports and exports 
data, including processes for mapping source company accounts to destination company 
accounts.

 l Chapter 3: Consolidating Transactions

Consolidate general ledger data, including account nets and balances, transactions from a 
fiscal period or range of posting sequences, budget balances, source codes, segment codes, 
accounts, optional fields, account groups, and transactions.

 l Chapter 4: Printing G/L Consolidations Reports

Use G/L Consolidations report screens to print setup reports and analytical reports.

 l Appendix A: G/L Consolidations Screen Guides

Learn how to find and use Sage 300 screens. Each screen guide includes navigation 
information, field help, and a list of tasks you can use the screen to perform.

 l Appendix B: G/L Consolidations Security Authorizations

If security is turned on for your Sage 300 system, the system administrator must assign users 
security authorization for G/L Consolidations screens.

This appendix describes the authorizations you can assign to G/L Consolidations users.

 l Appendix C: Data Entry Tools, Tips, and Shortcuts

Use these tools and shortcuts to speed up data entry in Sage 300.

 l Appendix D: Support and Resources

Find support and resources to help get Sage 300 up and running quickly.
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Chapter 1: Key Concepts in G/L 
Consolidations

The following concepts form the basis of a thorough understanding of G/L Consolidations:

 l General Ledger is used to perform the consolidation.

 l You can set up the consolidated ledger in one of the following ways:

 l Create a separate general ledger solely to house the consolidation.

 l Use the head office general ledger to do the branch consolidation.

 l You can export and import accounts, nets, balances, transactions from a fiscal period or range 
of posting sequences, budget balances, source codes, segment codes, account groups, and 
optional fields.

 l Information is exported from the branch office general ledgers, and imported to the head office 
general ledger. Data can also be returned to the branch offices.

About Consolidating Account Codes, Segment Codes, and 
Source Codes
G/L Consolidations transfers account codes, segment codes, and source codes from the source 
company to the destination company.

When you consolidate these codes, you are importing the complete account code, segment code, or 
source code record into the destination general ledger.

If the record already exists in the destination ledger, it is updated with the new information.

Important! 
Import will fail if the records being imported cause an invalid update.

For example, if a single currency account is imported to a ledger where the existing account is 
multicurrency, import will fail because you cannot change the multicurrency setting for an account 
back to single currency.
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Using the Mapping Table to Consolidate Account Codes, Types, and Structures

You can consolidate companies with dissimilar account numbers, account types, and account 
number structures. The tool that lets you do this is the mapping table.

The mapping table lets you specify individual accounts that have different account numbers, 
structures, or settings from the equivalent accounts in the source ledger. This includes:

 l Changing destination accounts—numbers, descriptions, structures, and consolidation options.

 l Mapping multicurrency accounts to single currency destinations, and single currency accounts 
to multicurrency destinations.

 l Changing exchange rate types.

The mapping table that is used during the export process is in the source company database.

You can use a mapping table to match source company   accounts to destination company accounts 
as follows:

 l Source company   accounts can be matched to destination company accounts on a one-to-one   
basis, where account numbers are dissimilar.

 l Source company   accounts can be matched to destination company accounts on a many-to-
one   basis, if you need to merge source accounts.

 l Source company   accounts and destination company accounts can have different consolidation   
options or different multicurrency settings.

 l The rate types   for individual accounts can be different from the default rate type (where   
translation occurs). 

Tip: We strongly recommend that both the exporting and importing companies have the same 
account structure codes. If they do not, you should use the mapping table to map all exported 
accounts. For more information, see "G/L Consol.  Mapping Table" (page 72).

About Multicurrency and Single Currency Account Consolidations

If you are consolidating accounts, you must use the mapping table to export account records from a 
single currency company to a multicurrency company – or from a multicurrency company to a single 
currency company.

Note: You cannot import account data to an account with a different multicurrency/single currency 
setting.
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Restrictions on Consolidating Account Codes, Segment Codes, and Source 
Codes

The main restrictions to consolidating involve transferring accounts between multicurrency and single 
currency ledgers.

The rule is that you can only import accounts that you can save in the destination ledger. This means, 
for example, that you cannot import:

 l Multicurrency accounts in a single currency destination.

 l Single currency accounts that replace multicurrency accounts in the destination ledger.

 l Segment codes that are the wrong length or that are for a segment that does not exist in the 
destination ledger.

 l Accounts that use allocation accounts that do not exist in the destination ledger.

 l Accounts with account groups that do not exist in the destination ledger.

For more information, see "Troubleshooting Import Problems" (page 34).

About Specifying Account Segments for Export

When you select Specify Segment Code For Export on the G/L Consol Export Setup screen, G/L 
Consolidations lets you restrict export data to accounts that have a particular range of values 
associated with a selected segment.

Note: If you select this option, you must also select a Balancing Account on the Main tab.
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Example: 
Suppose you have a holding company (Company A) with two subsidiaries (Company B and 
Company C):

Also, suppose that the following account code structure exists in all three companies:

Segment Number Segment Name

1 Account

2 Company

3 Division

You transfer data for the companies as follows:

 l Subsidiaries C and B export data to holding Company A.

 l Some entries relating to Companies B and C are entered directly into Company A, and these 
entries must be transferred back to B and C.

To transfer these entries, you must use the G/L Consol Export Setup screen to define two 
separate export processes in Company A. For each of these processes:

 1. Select Specify Segment Code for Export.

 2. Select Segment Number 2.

 3. Enter the range in accordance with the destination subsidiary.

About Segment Number Substitution

If you are consolidating general ledger account segments, you can map account segment numbers in 
the source company to different account segment numbers in the destination company.
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Example: 
Suppose you have source and destination companies with different general ledger account 
segments:

Source Company Destination Company

Segment # Seg Name Segment # Seg Name

1 ACCT 1 ACCT

2 DIV 2 DIV

3 DEPT 3 REGION

  4 DEPT

In this case, you could map segment number 3 in the source company to segment number 4 in the 
destination company.

When mapping account segment numbers, you specify:

 l Source Segment Number. Enter or select the source segment number which you would like to 
map to a different segment number in the destination company.

 l Target Segment Number. Enter the number of the account segment that the source segment 
will be mapped to in the destination company.

    About Consolidating Budgets
Budget information is imported using the standard Sage 300 import function.

When you are consolidating budgets, you are replacing the contents of budget set 1 in the destination 
ledger with the budget information from the source ledger.
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Notes: 
 l You can export only the functional currency for budgets.

 l Imported budget information replaces destination information—it is not added to it.

 l You may find it easier to consolidate budget data from several source companies by 
adapting and using the sample VBA budget macro (in Budget.xls) included with System 
Manager. It reads budget information directly from a General Ledger database, and lets you 
update it with revised information.

 l Budgets do not use balancing accounts. (This account is used to create balanced 
transaction batches when consolidating account balances or net amounts and period or 
posting sequence transactions.)

 l You can choose which budget figures you want to transfer to the destination ledger (budgets 
1, 2, 3, 4, or 5), and you can specify a range of fiscal years.

Consolidate Option

If multiple source accounts are mapped to a single destination account, you use the Consolidate 
option on the Criteria tab of the G/L Consol Export Setup screen to specify whether or not to 
consolidate budget amounts from the source accounts into the destination account:

 l If the Consolidate option is selected, Export creates a single entry for import that consolidates 
the budget amounts.

 l If the Consolidate option is not selected, Export creates separate entries for import that 
consecutively replace each other. The last imported entry appears as the destination 
company's new budget amount.
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Example: 
Suppose accounts 1005, 1006, and 1007 are all mapped to account 1005 in the export file.

If the Consolidate option is selected, budget amounts are consolidated as follows:

Exported Account Mapping Exported Budget

1005 1005 -> 1005 1,000

1006 1006 -> 1005 1,200

1007 1007 -> 1005 1,500

 Total 3,700

Imported Account  Imported Budget

1005  3,700

If the Consolidate option is not selected, budget amounts are consolidated as follows:

Exported Account Mapping Exported Budget

1005 1005 -> 1005 1,000

1006 1006 -> 1005 1,200

1007 1007 -> 1005 1,500

 Total 3,700

Imported Account  Imported Budget

1005  1,500

About Consolidating Transactions
G/L Consolidations lets you transfer the following types of transactions from source companies to a 
destination company:

 l Account balances and net changes.

 l Transactions for a particular fiscal period or range of posting sequences.
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G/L Consolidations lets you export and import sufficient detail to ensure a complete consolidation 
process, including:

 l General Ledger records, such as:

 l Accounts.

 l Segment codes.

 l Source codes.

 l Optional fields.

 l Account groups.

 l Budget amounts.

 l Actual balances or period net amounts from transactions.

 l Transactions posted in a particular fiscal period or for a range of posting sequences.

You should understand how G/L Consolidations handles each type of General Ledger data before 
you use the program.

Tip: We strongly recommend that both the exporting and importing companies have the same 
account structure codes. If they do not, you should use the mapping table to map all exported 
accounts. For more information, see "G/L Consol.  Mapping Table" (page 72).

Consolidating Account Balances and Net Changes

You can export only one type of transaction at a time.

Account balances and net changes can be consolidated by creating batches of transactions from the 
source data that can be posted to general ledger accounts in the destination ledger.

When you choose to export account balances or net changes, you also specify:

 l A source ledger and source code to use for each transaction.

 l A transaction detail description for each transaction.

 l Whether you want to create zero amount transactions for accounts with a zero balance or zero 
net for a period.

 l A unit balancing account for situations in which the set of exported data is not balanced.

 l The maximum number of transaction details in an entry.

 l An entry balancing account to create balanced journal entries.

 l The period offset to use if the source and destination companies have different fiscal periods or 
year-ends.
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Unless you are exporting your complete chart of accounts in a single journal entry, G/L 
Consolidations adds a transaction detail to each journal entry to make it balance. You must specify 
the account number of this balancing account.

You can export all accounts, or perform a partial export.

Partial Exports

G/L Consolidations lets you export a specified range of accounts, known as a partial export. When 
performing a partial export, the program uses the unit balancing account to ensure that the 
destination company does not import an unbalanced set of transactions.

This feature is particularly useful in the following situation:

Companies B and C consolidate into Company A. However, payroll is processed in Company A, and 
entries arising from this must be transferred back to Companies B and C.

In other words, two partial export processes (that is, export of a range of accounts) must be defined in 
Company A for each of Company B and Company C.

All journal entries have an entry balancing detail if export creates several entries. G/L Consolidations 
allows you to specify the maximum number of transaction details in a journal entry. Because each 
journal entry must be balanced, the program adds an entry balancing detail to each entry whenever a 
transaction export spans several journal entries.

Transactions by Fiscal Period or Posting Sequence

When you consolidate transactions, you can choose to export posted transactions from the source 
ledger by fiscal period or by posting sequence, and then use the G/L Consol Export Setup screen to 
specify the following settings:

 l A source ledger and source code to use for each transaction.

 l If you then select Insert Original Audit Trail, the original General Ledger posting 
sequence, batch number, entry number, and detail number are added to the detail 
comment field, along with the original source account number to which the detail was 
posted.

 l If you then select Retain Original G/L Reference, G/L Consolidations adds the same 
reference information that was posted in the original General Ledger entry.

 l The maximum number of transaction details in an entry.
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 l An entry balancing account to create balanced journal entries.

 l Transaction optional fields.

Multicurrency Considerations for Consolidating Balances and Net Amounts

G/L Consolidations lets you mix single currency and multicurrency ledgers even where companies 
have different functional currencies.

In other words, with some restrictions, G/L Consolidations can consolidate data from a single 
currency company to a multicurrency company or from a multicurrency company to a single currency 
company. For more information, see "About Consolidating Account Codes, Segment Codes, and 
Source Codes" (page 3).

Notes: 
 l For account balances and net changes, only the functional currency amounts are exported, 

allowing you to import the transactions to either a single currency or a multicurrency ledger.

 l If you import the account balances or net amounts to a multicurrency ledger, G/L 
Consolidations will create transactions with a source currency that matches the functional 
currency.

 l If you are consolidating single currency companies with different functional currencies, you 
can translate the source account balances or net amounts to the destination functional 
currency as part of the export process.

Multilevel Consolidations

G/L Consolidations uses the concept of source and destination companies to achieve multilevel 
consolidations. The source company exports data; the destination company imports the same data. A 
company can be both a destination company and a source company, depending on whether the 
company is exporting or importing the data.

Example: 
Suppose you have companies structured as follows:

Company B is the destination company for data from Company D, and is the source company for 
the data sent to Company A.
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About Currency Translation
If the source and destination companies have different functional currencies, G/L Consolidations can 
convert the consolidation data to the functional currency of the destination company. This is called 
currency translation.

The following table shows the contents of the source currency and functional currency fields of 
transactions in the source ledger and the equivalent transactions created in the destination ledger, 
where the source and destination ledgers have different functional currencies:

 Source Ledger (CAD) Destination Ledger (USD)

Translate MC Source Functional MC Source Functional

1. N/A N N/A CAD N N/A USD

2. N/A N N/A CAD Y CAD USD

3. Funct. Y Various CAD N N/A USD

4. Funct. Y Various CAD Y CAD USD

5. Source Y Various CAD N N/A USD

6. Source Y Various CAD Y Various USD

Legend: MC=multicurrency ledger

Rows 1 to 4 apply when net amounts, balances, or transactions are exported. Rows 5 and 6 apply 
only when transactions are exported.

Accounts for Handling Currency Rounding Differences

In addition to transferring the account balances you specify during a consolidation, Sage 300 may 
also include amounts in the following accounts in order to adhere to Generally Accepted Accounting 
Principles (GAAP):

 l Income account to handle exchange gain due to rounding differences.

 l Expense account to handle exchange loss due mainly to rounding differences.

Source Currency of Exported and Imported Transactions

Unlike account balances and net amounts, transactions exported from a multicurrency ledger retain 
their source currency so you can retain that information in the destination ledger.
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The following table shows the source currency of transactions sent to the destination ledger under 
various single currency / multicurrency configurations.

In this table, the source and destination ledgers have the same functional currency.

Source Ledger Destination Ledger

MC Source Functional MC Source Functional

N      N/A      CAD      N      N/A      CAD      

N      N/A      CAD      Y      CAD      CAD      

Y      Various      CAD      N      N/A      CAD      

Y      Various      CAD      Y      Various      CAD      

Legend: MC=multicurrency ledger

Where both source and destination ledgers are multicurrency, transactions are created in the 
destination ledger with identical currency details as in the source ledger.

Where the source and destination companies have different functional currencies, G/L 
Consolidations can convert the consolidation data to the functional currency of the destination 
company.

Translating Source or Functional Currency Amount

When translating currencies from a multicurrency source ledger, you have the option to calculate the 
new functional currency amount from the source company’s functional currency amount or source 
currency amount.

If you translate the functional currency, the source ledger’s functional currency becomes the source 
currency in the destination ledger.

If you translate the source currency, you will retain the original source currency in the destination 
ledger.

There are a number of possible scenarios that can arise with regard to translations, such as:

 l Different rates are applicable to different transactions exported to the destination ledger 
(arising from different rate types for different accounts, or different rates on different 
transaction dates). See Example A: Balanced Export with Different Rate Types.

 l Different rates and a partial export. See Example B: Partial Export with Different Rate Types.
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Example A: Balanced Export with Different Rate Types

In this example, although the export is balanced (that is, a full export), the export process that uses 
the mapping table has specified that accounts 5000 and 5000-100 use the Daily Spot Rate (SP) 
instead of the default Monthly Average Rate (AV).

The resulting difference is thus attributable to the translation process, and G/L Consolidations creates 
an entry to the Gain/Loss currency translation accounts.

Account Source Ledger 
(ZAR)

Rate 
Type

Rate 
Date

Conversion 
Rate

Destination Ledger 
(USD)

 

5000 12,000 SP 15-
Jun-XX

R3=$1 4,000  

5000-100 (6,000) SP 20-
Jun-XX

R2=$1 (3,000)  

5000-200 (4,000) AV 30-
Jun-XX

R4=$1 (1,000)  

5000-300 (2,000) AV 30-
Jun-XX

R4=$1 (500)  

Total 0   Subtotal (500)  

    Gain/Loss Acct 
entry

 500

    Total 0  

Legend: R=ZAR; $=USD

Example B: Partial Export with Different Rate Types

The following example includes both an unbalanced (partial) export and different rates. In this case, 
G/L Consolidations differentiates between the entry needed to balance the export (Unit Balancing 
account) and any entry generated due to a gain/loss on translation (Gain/Loss on Translation 
accounts).

The process applies an exchange rate (dependent on which option you selected in Export Setup) to 
the value that is determined as the balancing amount in the source company’s functional currency, 
which is then posted to the Unit Balancing account. The resulting difference relates to the Gain/Loss 
on translation and is reflected in the Gain/Loss accounts.
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Account Source 
Ledger (ZAR)

Rate 
Type

Rate 
Date

Conversion 
Rate

Destination 
Ledger (USD)

 

5000-100      (6,000) SP 20-
Jun- 
XX

2:1 (3,000)  

5000-200      (4,000) AV 30-
Jun-
XX

4:1 (1,000)  

5000-300      (2,000) AV 30-
Jun-
XX

4:1 (500)  

Total (12,000)   Subtotal (4,500)  

Bal. Acct 12,000 AV 30-
Jun-
XX

4:1 (1) 3,000  

    Subtotal (1,500)  

    Gain/Loss 
Acct entry

 (2)
1,500

    Total 0  

(1) Unit Balancing

(2) Gain/Loss on Translation

Notes: 
 l When translating by transaction date, the Transaction Date field on the G/L Consol Export 

screen determines the exchange rate for translating the Unit Balancing account (which 
balances the export).

 l G/L Consolidations uses the same date even if there is a period offset. In other words, period 
offset has no effect on the exchange rate of the Unit Balancing account when translating by 
transaction date.

 l When translating by fiscal period, the exchange rate for translating the Unit Balancing 
account is based on the period of the importing company.
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About Period Offset for Differing Fiscal Periods
Source companies do not need to have the same fiscal year as the destination company. For each 
source company, you can specify the number of periods by which the destination company differs 
(the offset) from the source company.

Warning! Companies must have the same number of periods. Although source and destination 
companies do not need to have the same year-end, they must have the same number of fiscal 
periods.

Warning! Budgets cannot be consolidated with an offset. You cannot export budgets if you are 
using the Period Offset option.

Example: 
Suppose the source company has a 31 December year-end, and the destination company has a 31 
March year-end:

To synchronize the periods, transactions exported from the source company need to use an offset 
of -3 (because period 5 in the source company equals period 2 in the destination company).

Note: Periods one through three in the source company would be exported to periods ten 
through twelve of the previous year in the destination company. The Adjustment Period (14) is 
always exported to period 14 in the destination company. Period 15 cannot be exported.

Exchange Rates Used for Currency Translation with a Period Offset

When you use currency translation, you must select one of the following methods to use when 
determining the dates for exchange rates:

 l Fiscal period. Mo re ...

If the currency translation rates are based on the fiscal period, G/L Consolidations bases the 
exchange rates on the last day of the source (exporting) company's fiscal period when the 
transaction occurred.
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Note: The fiscal period used for the exchange rates is not affected by the offset.

If you are using a period offset and currency translation rates are based on the fiscal period, 
G/L Consolidations bases the exchange rate on the source (exporting) company's period 
before the offset was applied.

Note: This date must be the last day of the fiscal period.

 l Transaction date. Mo re ...

If the currency translation rates are based on the transaction date, G/L Consolidations chooses 
the exchange rate in effect on the date of the transaction in the source (exporting) company.

 l Specified. Mo re ...

When you select the Specified option, you enter the date at the time of the export.

About Audit Trails
In addition to providing an Audit Trail Report, G/L Consolidations inserts audit information directly into 
the general ledger batch header and detail fields when the import process creates batches in the 
destination company.

This audit trail information enables transactions in a destination company to be traced back to 
documentation in the source company.

G/L Batch Header Fields

The following audit information is inserted into general ledger batch headers:

 l Batch. The description for the batch follows this pattern: Imported from Unit ID/Export 
Sequence Number.

Example: Imported from IMP2/0020

 l Entry. The description for each entry in the batch follows this pattern: Import File - Unit 
ID/Export Sequence Number.

Example: Import File - IMP2/0020

G/L Batch Detail Fields

The following audit information is inserted into details in general ledger batches:
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 l Comments. If you are consolidating transactions by fiscal period or posting sequence, this field 
displays the original general ledger source account number.

Depending on how the Insert Original Audit Trail option is set on the Transactions tab of the 
G/L Consol Export Setup screen, this field may also display the original General Ledger posting 
sequence number, batch number, entry number, and transaction detail number.

 l Description. If you are exporting account net changes or balances, you can specify the 
transaction detail description on the Transactions tab of the G/L Consol Export Setup screen.              

Note: If you are exporting transactions for a fiscal period or posting sequence, the field 
retains the description from the original transaction.

 l Reference. The reference field displays Process ID/Unit ID/Export Sequence Number.

Example: ACCTEXP/IMP2/ 0020
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Chapter 2: Setting Up G/L Consolidations

Use G/L Consolidations Setup screens to:

 l Validate and manage import files from source companies.

 l Manage the mapping process of source company accounts to destination company accounts.

 l Create export processes to define the general ledger data to export.

Adding a Source Company ID for Importing
Use the G/L Consol Import Unit Maintenance screen to create and manage unit   IDs unique to each of 
a destination company's source companies, and to specify   and check the functional currency of the 
source company.

Note: A destination company   cannot import any G/L data from a source company until a source 
unit ID has been   added on the G/L Consol Import Unit Maintenance screen that uniquely identifies 
the   source company. 

To add a source company ID:

 1. Open General Ledger > G/L Consolidations > G/L Consol. Setup > Import Unit 
Maintenance.

 2. In the Source Unit ID field, enter a new ID to identify the source company.

 3. In the Description field, enter a description for the company.

 4. Select the source company's functional currency.

 5. Click Add.

After adding a source company ID

After creating a source company ID, you can perform an import.

Note: The source unit ID must match the ID specified on the G/L Consol Export Setup screen, and 
the functional currency must be the same as that specified in the export from the source company.
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Setting Up a Mapping Table
Use the G/L Consol Mapping Table screen to specify how individual   accounts can be consolidated, 
created or converted. 

Mapping tables are required only if you need to change account codes,   account segments, account 
structures, or rate types while exporting, or if you want to   merge account balances, net changes, or 
budgets while exporting.

You must also use a mapping table when you export account records   from a single currency 
company to a multicurrency company, or from a   multicurrency company to a single currency 
company.

Note: We strongly recommend   that both the exporting and importing companies use the same 
account   structure codes. If they do not, you should use the mapping table to map   all exported 
accounts.

To set up a mapping table:

 1. Open General Ledger > G/L Consolidations > G/L Consol. Setup > Mapping Table.

 2. Enter an ID of up to 8 characters for a new mapping table, and enter a description.

 3. Map accounts in the source company's general ledger to accounts in the destination 
company's general ledger. Mo re ...

Notes: 
 l At any time, you can click the Validate button to check that the source account 

numbers are correct. Any rows with invalid accounts are deleted from the list.

 l If you leave target fields blank, the program uses the corresponding information from 
the source company. For example, if you leave the Target Account field blank, the 
program uses the source account number.

 a. In the Source Account column, select the general ledger account number for the 
account in the source ledger that you want to map.

 b. In the Target Account column, enter the account number for the account in the 
destination company that you want to map to.

 c. In the Target Account Description column, enter a description, or leave the field blank 
to use the source account description.

 d. In the Target Structure Code column, enter a structure code, or leave the field blank to 
use the source account’s general ledger account structure.
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 e. In the Closing Segment Number column, enter the closing segment number for the 
target account, or leave the field blank to use the source account’s closing segment.

 f. In the Posting Type column, select a posting type.  Mo re ...

 l Consolidate. Select this type if the target account in the destination company is 
consolidated.

 l Detail. Select this type if the target account in the destination company is detailed.

 l N/A. Select this type to use the setting of the source company's source account.

 g. In the Rate Type column, specify a different rate type than the default rate type if 
currency translation is relevant for the consolidation process.  Mo re ...

Specifying a rate type lets you ensure compliance with Generally Accepted Accounting 
Principles when certain account balances need to be translated using different rate 
types.

For example, you may have to translate some account balances at spot rates, others at 
average rates and others at historic rates. All these rate types can be set up and 
recorded in the mapping table to ensure consistent application of the different rate types.

If you leave the Rate Type field blank, G/L Consolidations uses the default rate type 
specified for the export process on the G/L Consol Export Setup screen.

 h. In the Multicurrency column, specify whether the destination company is multicurrency. 
Mo re ...

 l Yes. Select if the destination account in the destination company is multicurrency, 
and the account in the source ledger is single-currency. (If you select Yes, G/L 
Consolidations assumes that all currencies are valid for that account in the target 
ledger.)

 l No. Select if the destination account in the destination company is single-currency, 
and the account is multicurrency in the source ledger.

 l N/A. Use the setting of the source account in the source company.       

Example: If the source ledger is set up as single-currency with a functional currency 
of USD, and the destination ledger is set up as multicurrency with a functional currency 
of CAD, you select Yes. Upon successful import in the destination ledger, both the 
source currency (USD) and the functional currency (CAD) will appear in the 
transaction exported to the destination ledger. 

Note: You cannot change a multicurrency account to single-currency, and you cannot 
change a single-currency account to a multicurrency account.
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 4. When you have finished adding accounts, click Validate to to check that the source account 
numbers are correct. Any rows with invalid account are deleted from the list..

 5. Click Add to add the mapping table.

Creating a Process ID to Specify General Ledger Data for 
Export
Use the G/L Consol Export Setup screen to create process IDs that specify general ledger data to 
export from a source company. 

For more information about this screen, see "G/L Consol. Export Setup Screen" (page 59).

Before You Start

If you want to change account codes,   account segments, account structures, or rate types while 
exporting, or if you want to   merge account balances, net changes, or budgets while exporting, set up 
a mapping table to be used in this export process. For instructions, see "Setting Up a Mapping Table" 
(page 22).

To create a process ID:

 1. Open General Ledger > G/L Consolidations > G/L Consol. Setup > Export Setup.

 2. Enter a code of up to eight characters to describe the export process, and enter a description 
for the process in the field to the right.

 3. Use the Main tab to specify the unit ID of the source company from which you are exporting 
data,   and to select data to be exported.Mo re ...

 a. Enter a Unit ID   of up to four characters that identifies the source company when the   data 
is imported into the destination company.

 b. Select a unit   balancing account   that will be used in situations   where exported data is not 
balanced. For more information, see "About Consolidating Transactions" (page 9).

 c. In the Data area, select the type or types of data to export.

 d. If you want to be able to clear data selections on the G/L Consol Export screen later, 
select the Allow Runtime Edit option. 

 4. If you selected   Transactions in the Data section on the Main tab, use the Transactions   tab   to 
select options specific to transactions. Mo re ...

 a. Select an export method (net changes, balances, transactions by posting sequence, or 
transactions by fiscal period).
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 b. If you use Transaction Analysis and Optional Field Creator and you selected   
Transactions By Fiscal Period or Transactions By Posting Sequence, select  the 
Transaction Opt. Fields option so that optional fields attached   to the transactions will 
be included in the export.

 c. Select the transaction source ledger to use for each imported journal entry.

 d. Select the default source code.

 e. If you want to limit the number of transaction details per general ledger entry, enter the 
number of transactions and specify the transaction balancing account that will receive 
balancing details.

 f. If you selected Transactions By Posting Sequence or Transactions By Fiscal Period 
as the export method and you are converting source codes, use the Source Code 
Conversions table to specify how source codes are converted during export.

 5. If you selected Budgets on the Main tab, use the Criteria tab to specify the budgets to be 
exported. Mo re ...

 a. If you want to restrict export data to accounts that have   a particular segment in the 
account number, or to a particular range of values   associated with that segment, select 
the Specify Segment Code for Export option, and specify a range of segment number 
values to include.

Note: If you select Specify Segment Code for Export, you must also select a 
balancing   account on the Main tab. For more information, see "About Specifying 
Account Segments for Export" (page 5).

 b. If you selected budgets for export on the Main tab, select the budget sets (1 to 5) for 
exporting, and select the fiscal year containing the budget sets to be exported.

If you are using a mapping table to consolidate accounts (in other words,   if you are 
merging many source ledger accounts into one destination ledger   account), select the 
Consolidate option to consolidate the budgets for   all of the source accounts that are 
being merged.

 l If you select Consolidate, the relevant budget amounts will also be consolidated 
according to the mapping table. 

 l If you do not select Consolidate, only the budget for the last merged source ledger 
accounts will appear in the destination accounts.

 6. If  the   destination company is multicurrency, use the Currency   tab   to set up multicurrency 
options. Mo re ...
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 a. If the destination company is multicurrency, select Multicurrency   Destination 
Company.

 b. If the source and destination companies use the same functional currency, specify the 
default rate type.

 c. If the source and destination companies do not use the same functional currency, set up 
currency translation. Mo re ...

 i. Select the Translate   to Different Functional Currency option.

 ii. Enter the currency code for the destination company's functional currency.

 iii. Specify the default rate type for transactions and budgets.

 iv. In the Translation Rate Date area, specify how exchange rates will be applied. Mo re ...

 l Fiscal   Period. The program will   base the exchange rates on the last day of 
the source (exporting) company's   fiscal period when the transaction 
occurred. 

Note: The fiscal period   used for the exchange rates is not affected by the 
offset. 

 l Transaction   Date. This option is available only if detailed transactions are   
being exported (instead of balances or net changes). 

The exchange rate will be based on the rate in effect   on the actual dates of 
the original transactions in the source (exporting)   company.

 l Specified. If you select this option, you will be required to enter a rate   date 
at the time of export. 

 v. Specify currency translation accounts for gain and loss.

 7. Use the Mapping tab to specify whether   or not a mapping table is used for the export process, 
and to map General   Ledger account segments. Mo re ...

For more information about mapping tables, see "G/L Consol.  Mapping Table" (page 72).

If you will use a mapping table for this process:

 a. Select the Use   Mapping Table   option.

 b. Select a mapping table. For information about setting up, see "Setting Up a Mapping 
Table" (page 22).

 c. Specify a mapping method to use.

 d. If you selected Segment   Codes on the Main tab, use the Segment Number Substitution 
table to select a source segment number and map it to a target segment number.

 8. Click Add to add the new export process.
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After creating an export process ID

Export data from the source company. For instructions, see "Exporting General Ledger Data" (page 
31).
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Chapter 3: Consolidating General Ledger 
Data

After you set up G/L Consolidations, the process of consolidating general ledger data is very 
straightforward. You can consolidate account nets and balances, transactions from a fiscal period or 
range of posting sequences, budget balances, source codes, segment codes, accounts, optional 
fields, account groups, and transactions.

In the simplest case, you perform the following steps:

 1. Export data from the branch general ledger. 

For more information, see "Exporting General Ledger Data" (page 31).

 2. Send the exported data to the head office.

If the head office general ledger is on the same network as the branch office, the exported data 
can be easily copied to the directory used by the head office.  

 3. Import the data to the head office general ledger.

Importing data replaces information in records that already exist. For example, if you import 
budget data for an account that already exists in the head office database, the imported 
information will replace the original head office information, which also means that you cannot 
import a single-currency account that replaces an existing multicurrency account.

The import process performs the following steps:

 l Creates batches for all transactions you are importing, such as account balances, net 
amounts, or transactions for a fiscal period or range of posting sequences.

 l Adds account information, account code segments, source codes, account groups, 
budgets, and optional field data directly to the head office general ledger database.

Note: You cannot change the sort code of an account group that already exists in the 
destination company.

 4. Post the imported transactions.
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About Exported Files
Depending on the general ledger data being exported, G/L Consolidations creates between two and 
six files. These files are generated and copied to the export directory specified for the export process 
on the G/L Consol Export Setup screen. The same files are saved to an archive directory in the 
source company.

Archive Folder for Exports

Exported files are saved to an archive folder on the server, based on the date of the export.

Archival exports are saved within the installation path in the following folder: 

\Company\CompanyID\ZCexport (where CompanyID represents the source company).

The program saves the exported records in a subfolder named YYYY-MM-DD (where YYYY 
represents the year, MM the month, and DD the day of the export).

If you export more than once on the same day, later exports are archived to the same folder, with 
newer exports added to the earlier file list.

Note: Exported data remains permanently in this folder, and should be deleted regularly.

File Naming Convention

G/L Consolidations creates unique file names for exported files, using eight characters for the file 
name and three characters for the file extension, as follows:

 l The first four characters of the file name are reserved for the unit ID (this is unique for each 
source company).

Example: UNIT_ _ _ _ . _ _ _

 l The next four characters of the file name are reserved for the export sequence number. The 
export sequence number is incremented each time general ledger data is exported from the 
source company (no matter which export process is used). It ranges from 0001 to 9999. For 
more information, see "G/L Consol. Import Screen" (page 45).

Example: UNIT0001._ _ _
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 l The three-character file extension identifies the type of data in the export file.

Extension Data Type Description

ZCC Control File This file is generated for each export and contains 
information about the export. This file must also be 
present in the import directory for any of the files listed 
below to be imported.

The following files are created for each type of data in the export:

Extension Data Type Description

001 Transactions Summary account data or posted transactions by fiscal 
period or by posting sequence.

ACT Accounts Exported G/L accounts, including account optional fields.

AGP Account Groups Exported account groups.

BDG Budgets Exported budgets.

CSF CS Optional 
Fields

Optional fields exported from Common Services 
Optional Fields setup.

OFD G/L Optional 
Fields

Optional fields exported from G/L Optional Fields setup.

SEG Segment Codes Exported G/L segment codes.

SRC Source Codes Exported G/L source codes.

Exporting General Ledger Data
Use the G/L Consol Export screen to export data according   to the processes defined on the G/L 
Consol Export Setup Screen.

Before You Start

 l In the source company, create   a process ID for the export process. For instructions, see 
"Creating a Process ID to Specify General Ledger Data for Export" (page 24).

 l Add a folder   to your company network to save the exported files.
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To export general ledger data:

 1. Open General Ledger > G/L Consolidations >  Export.

Note: Only one user at a time can use the G/L Consol Export screen.

 2. Specify a process   ID   to use for the export. For information about creating a process ID, see 
"Creating a Process ID to Specify General Ledger Data for Export" (page 24).

 3. Click the Browse button beside the Export Folder field to select the   folder you created for the 
exported files.

 4. If you selected   Allow   Runtime Edit   when setting up the export process you are using, you can 
clear any of the options selected in the Export Data Selection area.

 5. If the export method is balances, net changes, or transactions by fiscal period, you can change 
the year and period.

 6. Click Export.

After exporting general ledger data

Use the G/L Consol Import screen to import data from the export file to the destination company. For 
instructions, see "Importing General Ledger Data" (page 32).

Importing General Ledger Data
Use the G/L Consol Import screen to import files from a source company to a destination company.

For information about import problems and how to resolve them, see "About Import Problems" (page 
34) and "Troubleshooting Import Problems" (page 34).

Before You Start

 l In the source company, create   a process ID for the export process. For instructions, see 
"Creating a Process ID to Specify General Ledger Data for Export" (page 24).

 l Add a folder   to your company network to save the exported files.

 l Export data from the source company. For instructions, see "Exporting General Ledger Data" 
(page 31).

 l Create a source unit ID in the destination company with the same ID as the process ID of the 
exported file. For instructions, see "Adding a Source Company ID for Importing" (page 21).
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To import data to G/L Consolidations:

 1. Open General Ledger > G/L Consolidations >  Import.

 2. Select an import selection method. 

If you select Net Changes, Balances, or Fiscal Period, the Year/Period field becomes 
available.

 3. Click the Go  button to see control files that match the criteria you selected.     

 4. Click the Add to List button.     

The Add To Import List window appears.

 5. Click the Browse button, specify the location where the files exported from the source 
company are stored, and then click OK.              

 6. Click Add to add the exported files to the list for importing.               

Data from the exported files appears in the table.

 7. If more than one line is displayed on the G/L Consol Import screen (that is, more than one 
import file was in the export folder) but you are importing only one set of data, select No in the 
Import column for each row you do not want to import.

To change the value from Yes to No, double-click the cell, or select the cell and press the 
spacebar.

 8. Check that the Can Import field displays Yes for the data you are importing.

 9. Click Import.     

During the import process, the stored export files       are deleted from the temporary storage 
location and saved to an archive      folder.

Files imported successfully will be archived within the installation path in the following folder 
(where CompanyID is the destination company):

\Company\Company ID\ZCimport\Archive

When importing is complete, a message displays information about data that was imported 
successfully or could not be imported.

 10. Close the G/L Consol Import screen.

 11. Check your records to confirm that data was imported successfully. If any errors occurred, use 
the G/L Consol Export Setup screen to correct any setup errors in the source company, and 
then perform the export and import again.

33Sage 300 2022 G/L Consolidations User's Guide



About Import Problems
The most common cause of import problems is that you are trying to import records that are invalid in 
the destination database. Typical invalid records are:

 l Multicurrency accounts in a single currency destination.

 l Single currency accounts that replace multicurrency accounts in the destination ledger.

 l Segment codes that are the wrong length or that are for a segment that does not exist in the 
destination ledger.

 l Accounts that use allocation accounts that do not exist in the destination ledger.

 l Accounts with account groups that do not exist in the destination ledger.

If the import program encounters an invalid record, it stops importing and creates a restart record for 
the import process. A restart record specifies the import record that failed and what was happening 
when it failed. The record is identified by Unit ID and Export Sequence Number on the Restart 
Maintenance screen in Administrative Services.

Troubleshooting Import Problems
If the import program encounters an invalid record, it stops importing. For more information, see 
"About Import Problems" (page 34).

After you correct the problems with the import, you can restart the import process.

To restart the import process:

 1. Use the G/L Consol Export Setup screen to change the export process so the problem records 
are not exported, or are exported properly (such as by using a mapping table).

 2. Use the Restart Maintenance screen in Administrative Services to delete the restart record 
created by the import problem.     

Notes: 
 l The number appearing for the restart record is the export sequence number. For more 

information, see "G/L Consol. Import Screen" (page 45).

 l You must remove the restart record before you can restart importing.

 3. Run Export again, using the updated, corrected process.

 4. Run Import again.
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Chapter 4: Printing G/L Consolidations 
Reports

Use G/L Consolidations reports screens to print reports of:

 l Information about the last import for each source company.

 l Mappings set up between source and destination accounts.

 l Setup options for a specified export process.

 l Audit information for imports and exports.

Note: If the company does not maintain account groups, reports display N/A in the Account Group 
column.

Printing Tips
You can select a print destination for a report that is different from the default print destination.

Report Printing Options

You can print Sage 300 data in a variety of reports to view key information. Printed reports also serve 
as a source of backup information in case your data is damaged on your computer.

Sage 300 provides four destinations for printing reports. You can:

 l Print to a physical printer, to create permanent copies of the information.

 l Print to a preview on your screen, for quick review.

 l Print to a file that you can save, print later, import into another program, or transfer to other 
electronic media.

 l Print to e-mail, to send a report as an e-mail attachment.

For instructions on specifying the print destination for Sage 300 reports, see "Selecting a Print 
Destination" (page 36).

If you print reports to a physical printer, you can also specify a particular printer to use for printing a 
report. For instructions, see "Selecting a Printer for Reports" (page 37).
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Selecting a Print Destination

You can print reports to a printer, to the screen, to a file, or as an attachment to an e-mail message.

Note: If you are not assigned to a security group that has authorization to change the print 
destination, the only destination available is a physical printer.

To select a print destination:

 1. On the Sage 300 Desktop, click Print Destination.

 2. Select a print destination:

 l Printer. Print to a physical printer. Mo re ...

Note: If you have multiple printers, you can specify the one to use when you print. For 
more information, see "Selecting a Printer for Reports" (page 37).

Tip: If you want to confirm the destination printer, page size, and orientation each time 
you print a report, on the Desktop, click View > Print Preferences, and then select 
Confirm on print.

 l Preview. Display reports in a preview screen. Mo re ...

Note: From the preview screen, you can do things such as saving the report to a file, or 
printing the report to a physical printer.

 l File. Print to a file. Mo re ...

When you print, you specify details about the file to create, including:

 l Format (for example, PDF, DOC, or XLS).

 l Destination.

 l Name.

 l Location.

 l E-mail. Print reports as attachments to e-mail messages. Mo re ...

You specify the type of file to create:

 l Adobe Acrobat (PDF). You can open PDF files with Adobe Acrobat Reader 
(available as a free download from the Adobe Software website).
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 l Rich Text Format (RTF). You can open RTF files with most Windows and Linux 
word processing programs.

When you print a report, Sage 300 creates a PDF or RTF version of the report and 
attaches the report file to a new e-mail message.

 3. Click OK.

Selecting a Printer for Reports

When your print destination is Printer, Sage 300 prints reports to the Windows default printer, unless 
you have assigned a specific printer to a report.

The ability to assign different printers to different reports at print time means that you are not limited to 
printing to the default printer. For example, you can use a different printer to print item labels than you 
use to print inventory worksheets.

To assign a specific report to a specific printer:

 1. Open the report screen that you want to assign to a printer.

 2. On the report screen, click File > Print Setup.

The program displays the Windows default printer, but you can change the printer for a specific 
report.

 3. Select the Specific Printer option, and then select from the list the printer to use for this report.

The printer list includes all printers that have been added to the Printers and Faxes list in 
Windows.

 4. Select a paper source if you want to use a particular paper tray or paper stock for this report.

 5. Click OK to close the Print Setup screen.

To clear the assigned printer for a specific report:

 1. On the Sage 300 Desktop, do one of the following:

 l Select (highlight) the icon for the report, and then click Object > Restore Defaults.

 l Right-click the icon for the report, and then click Restore Defaults on the list that 
appears.

 2. In the Restore Defaults screen, select the Print Settings option, and then click OK.

The print setup for that report is reverted to the desktop default.
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To have the program prompt you to specify a printer and print options each time you 
print:

On the Sage 300 Desktop, click View > Print Preferences, and then select Confirm on print.

Printing the G/L Consol. Import Unit Maintenance Report
The G/L Consol Import Unit Maintenance report lists the details of the last import from each source 
unit (company), in order of source currency. The report also displays the export method, and what 
was imported (for example, accounts, budgets, or optional tables).

To print the G/L Consol. Import Unit Maintenance report:

 1. Open General Ledger > G/L Consolidations > G/L Consol. Reports > Import Unit 
Maintenance.

 2. Specify a range of unit IDs to include in the report.     

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can 
print the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print 
button.

 l If you are printing to a file, the Export window appears. Specify the file format (for 
example, PDF, DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified 
format (for example, if you specify PDF as the file format, the report opens in Adobe 
Acrobat). You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system 
when you print. When you print to a file, the report is assigned a unique name, for 
example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Printing the G/L Consol. Export Setup Report
The G/L Consol Export Setup report lists all the setup options used to define export processes.

To print the G/L Consol. Export Setup report:

 1. Open General Ledger > G/L Consolidations > G/L Consol. Reports > Export Setup.

 2. Specify a range of process IDs to include in the report.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can 
print the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print 
button.

 l If you are printing to a file, the Export window appears. Specify the file format (for 
example, PDF, DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified 
format (for example, if you specify PDF as the file format, the report opens in Adobe 
Acrobat). You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system 
when you print. When you print to a file, the report is assigned a unique name, for 
example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the G/L Consol. Mapping Table Report
The G/L Consol Mapping Table report shows how accounts are mapped from the source to the 
destination ledger for a range of mapping tables and account IDs. The report also includes the 
mapping method and segment substitutions.
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To print the G/L Consol. Mapping Table report:

 1. Open General Ledger > G/L Consolidations > G/L Consol. Reports > Mapping Table.

 2. Specify a mapping table.

 3. Specify a range of source accounts to include in the report.

 4. Click Print.

Printing the G/L Consol. Export Audit Report
The G/L Consol Export Audit report lists information on each export procedure you have run for one 
or more export processes.

To print the G/L Consol. Export Audit report:

 1. Open General Ledger > G/L Consolidations > G/L Consol. Reports > Export Audit.

 2. Specify the criteria by which to print the report.

 l Process ID. Select Process ID and specify a range of process IDs.

 l Date. Select Date and specify a range of dates.

 l Fiscal Period. Select Fiscal Period and specify a range of fiscal years and periods.

 l Sequence Number. Select Sequence Number and specify a range of sequence 
numbers.

 3. If you want to reprint previously printed items, select Reprint Previously Printed Items.

 4. If you want to clear items after printing, select Clear After Printing.

 5. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can 
print the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print 
button.

 l If you are printing to a file, the Export window appears. Specify the file format (for 
example, PDF, DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified 
format (for example, if you specify PDF as the file format, the report opens in Adobe 
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Acrobat). You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system 
when you print. When you print to a file, the report is assigned a unique name, for 
example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the G/L Consol. Import Audit Report
The G/L Consol Import Audit report lists information on every import procedure you have run.

To print the G/L Consol. Import Audit report:

 1. Open General Ledger > G/L Consolidations > G/L Consol. Reports > Import Audit.

 2. Specify the criteria by which to print the report.

 l By unit ID and process ID. Select Unit ID, Process ID and specify the ranges of unit 
IDs and process IDs to include.

 l By import date. Select Import Date and specify the range of dates to include.

 l By unit ID and fiscal period. Select Unit ID, Fiscal Period and specify the ranges of 
unit IDs and fiscal years and periods to include.

 l By sequence number. Select Import Sequence Number and specify the range of 
sequence numbers to include.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can 
print the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print 
button.

 l If you are printing to a file, the Export window appears. Specify the file format (for 
example, PDF, DOC, or XLS). Also, specify a destination for the file:
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 l Application. View the report in an application that can open files of the specified 
format (for example, if you specify PDF as the file format, the report opens in Adobe 
Acrobat). You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system 
when you print. When you print to a file, the report is assigned a unique name, for 
example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Appendix A: G/L Consolidations 
Screen Guides

Learn how to find and use Sage 300 screens. Each screen guide includes navigation information, 
field help, and a list of tasks you can use the screen to perform.

Consolidations Screens
Use the Import and Export screens to transfer general ledger transactions from source companies to 
a destination company, so you can consolidate transaction data.

G/L Consol. Export Screen

To Open this Screen

Open General Ledger > G/L Consolidations >  Export.

Related Tasks

 l "Exporting General Ledger Data" (page 31)

 l "Importing General Ledger Data" (page 32)

 l "Creating a Process ID to Specify General Ledger Data for Export" (page 24)

 l "Consolidating General Ledger Data" (page 29)

 l "Printing the G/L Consol. Export Audit Report" (page 40)

Overview

Use the G/L Consol Export screen to export data according   to the processes defined on the G/L 
Consol Export Setup Screen.  For more information about setting up processes, see "Creating a 
Process ID to Specify General Ledger Data for Export" (page 24).

If the destination company is on the same network as the source company,   the destination company 
can import directly from the source company's export folder.
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For step-by-step instructions on exporting data, see "Exporting General Ledger Data" (page 31).

Note: Each export is saved to an archive   folder in the source company. For more information, see 
"About Exported Files" (page 30).

Fields and Controls

Buttons

Export

Click Export to export data from a source company according   to the processes defined on the G/L 
Consol Export   Setup   screen.

Currency   Conversion Rate Date

If the translation rate date was set to Specified   on the Currency tab of the G/L Consol Export Setup 
screen, this field displays the translation rate date.

Description

Enter a description for the process ID.

Export   Data Selection

These fields display the data that will be exported by the selected   export process.

 l If you selected Allow Runtime Edit on the Main tab of the G/L Consol Export Setup screen 
when   creating this export process, you can clear any of the data set for the   export.

 l If you did not select Allow Runtime Edit, you cannot change   the data selection for this export 
process. This feature provides a higher   level of control over the data that is exported.

Export   Folder

Specify a folder to which to export General Ledger data.

Export   Method

If you are exporting transactions, this field displays the type of transactions   that are being exported—
that is, balances, net changes, transactions   by posting sequence, or transactions by fiscal period.
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From/To Posting Sequence

These fields are available if the export method is Transactions by Posting   Sequence. Enter the 
range of posting sequences to export.

Process   ID

A process ID identifies an export process. Use the Process ID field to select an existing process ID, 
or to create a new one up to eight characters long.

Transaction   Date

This field appears only if you are exporting transactions by posting   sequence, and the Translation 
Rate Date option on the Currency tab of the G/L Consol Export   Setup screen has been set to 
Transaction Date.

The transaction date determines the exchange rate for translating the   Unit Balancing account entry 
that is created by the application to balance   the export.

Unit   ID

This field displays the unit ID specified on the G/L Consol Export Setup screen for the   selected 
export process .

In the destination company, you enter this ID in the Source Unit ID   field on the G/L Consol Import 
Unit Maintenance screen before importing.

Year/Period

This field is available if the export method is   Transactions by Fiscal Year/Period, or if you are 
exporting by net changes or balances.

Specify the fiscal year and period for which to export data.

G/L Consol. Import Screen

To Open this Screen

Open General Ledger > G/L Consolidations >  Import.
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Related Tasks

 l "Importing General Ledger Data" (page 32)

 l "Troubleshooting Import Problems" (page 34)

 l "Exporting General Ledger Data" (page 31)

 l "Consolidating General Ledger Data" (page 29)

 l "Printing the G/L Consol. Import Audit Report" (page 41)

Overview

Use the G/L Consol Import screen to import files from a source company to a destination 
company. For instructions, see "Importing General Ledger Data" (page 32).

Files to be imported must already have been exported from the source company.

Note: Only one user at a time can open the G/L Consol Import screen.

Fields and Controls

Buttons

Add To List

Click Add to List to open the Add to Import List window.

Important! All export   files are removed from the folder during the import process. Make sure you 
back up all exported files before proceeding.  Import records   are copied from the export folder to 
the \Company\Company   ID\ZCImport folder in the installation path.

Close

Click Close to close the screen.

Import

After you select general ledger data to import, this column displays one   of the following states: 

 l Yes. The selected   data can be imported.

 l No. The selected data   cannot be imported.
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 l N/A. The data is not available   for import.

Note: 
If   you are importing optional fields, they will not be imported in the following cases:

 l If the destination   company does not have a license for Transaction Analysis and Optional 
Field Creator.

 l If the optional fields   being imported do not match the optional fields created in General 
Ledger   Optional Fields Setup or in Common Services Optional Fields Setup in the   
destination company.

Import   Selection Method

Specify criteria to filter imported data: 

 l Net Changes. Only files exported by net changes for the fiscal period and year specified will 
be available for import.

 l Balances. Only files exported by balances for the fiscal period and year specified will be 
available for import.

 l Fiscal Period. Only transactions   exported by fiscal period for the fiscal period and year 
specified will be available for import.

 l Posting Sequence. Only files   exported by posting sequence will be available for import.

 l All Data. All exported files   will be displayed for possible import.

Note: The files available are limited to those contained in the   specified import directory.

Table

Accounts

Double-click the Accounts column to toggle between Yes and No. The column can display the 
following values:

 l No. Do not import accounts.

 l Yes. Import accounts.

 l N/A. Accounts were not included   in the data to be exported.

 l Missing. Accounts were exported,   but the file (UnitSEQ#.ACT)   is not in the import directory.

 l Aborted. The import was stopped  before the procedure was complete.

 l Previously Imported. You cannot   import the same data twice.
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Account   Groups

This column displays Yes if you included account groups as data to be exported when setting up the 
export process ID.  If you did not select account groups, this column displays N/A.

You can double-click the column to toggle between Yes and No. The column can display the 
following values:

 l No. Do   not import account groups.

 l Yes. Import   account groups. (You can double-click on the field to change it to No.)

 l N/A. Account   groups were not included in the data to be exported.

 l Missing. Account   groups were exported, but the file (UnitSEQ#.AGP) is not in the import 
directory.

 l Aborted. The import was halted   before the procedure was complete.

 l Previously Imported. You cannot   import the same account groups more than once.

Account   Optional Fields

This column displays Yes if you included account optional fields as data to be exported when setting 
up the export process ID.  If you did not select account groups, this column displays N/A.

You can double-click the column to toggle between Yes and No. 

Budgets

Specify whether to import budgets. You can double-click the column to toggle between Yes and No. 

The column can display the following values:

 l No. Do not import budgets.

 l Yes. Import budgets.

 l N/A. Budgets were not included   in the data to be exported.

 l Missing. Budgets were exported,   but the file (UnitSEQ#.BDG)   is not in the import directory.

 l Aborted. The import was halted   before the procedure was complete.

 l Previously Imported. You cannot   import the same budget more than once.

The Import Audit report displays these statuses, plus Not Imported (but   available) and Not 
Available.
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Can   Import

This column displays the following messages about availability of   general ledger data for import: 

 l Yes. The general ledger data   is available for import.

 l No. The general ledger data   is not available for import.

 l Not in Unit Maintenance. The   unit ID for the general ledger data has not been defined on the 
G/L Consol Import Unit   Maintenance screen. For more information, see "G/L Consol.  Import 
Unit Maintenance Screen" (page 69).

 l Same Sequence. This message   appears when the destination company tries to import 
general ledger data   with a unit ID and export sequence number that is the same as one 
previously   imported. You can override this warning and continue with the import process.

 l Bad Currency. This message appears   under the following circumstances: 

 l When the functional   currency of the source company does not match the functional 
currency   specified for the source company on the G/L Consol Import Unit Maintenance 
screen. For more information, see "G/L Consol.  Import Unit Maintenance Screen" 
(page 69).

 l When the translation   currency does not match the functional currency of the 
destination company.   You cannot import general ledger data until you fix the currency 
issue.

Currency

This column displays the functional currency for the set of import files.

Export   Method

This column displays the method of export for the set of import files.

Export   Sequence Number

Each time an export is performed, a file in the form of UUUU####.XXX   is created, where:

 l UUUU is the   unit ID

 l #### is the export sequence   number

 l XXX is the extension

Example: UNIT0001.ACT
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The program creates a number unique to each exported record. The number   is used to identify the 
import record corresponding to the set of exported   files being imported.

The export sequence number is also the number that appears in Restart   Maintenance if an import 
fails.

First   Posting Sequence/Last Posting Sequence

This column displays the range of posting sequences exported.

Optional   Fields from G/L Setup or from CS Setup

These columns display Yes if you included Optional Fields   From G/L Setup and/or Optional 
Fields From CS Setup as data to be exported when setting up the export process ID. You can 
double-click the column to toggle between Yes and No. 

If you did not select these options, these fields   display N/A.

Period

This field displays the fiscal period for the set of import files.

Possible   Duplication

This field displays messages about possible duplication:

 l None. No   apparent duplication.

 l Same Posting Sequence. If the general   ledger data was exported using the posting 
sequence method, this warning appears when data with the same unit ID and posting 
sequence   number has already been imported. There is a potential for duplications.

 l Same Fiscal Period. If   the general ledger data was exported using fiscal periods, this 
warning   is displayed when data with the same unit ID and fiscal year and   period has already 
been imported. There is a potential for duplications.

Process   ID

This field displays the process ID for the set of import files.

Segment   Codes

This column displays Yes if you included segment codes as data to be exported when setting up the 
export process ID.  If you did not select segment codes, this column displays N/A.
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You can double-click the column to toggle between Yes and No. The column can display the 
following values:

 l No. Do   not import segment codes.

 l Yes. Import   segment codes.

 l N/A. Segment   codes were not included in the data to be exported.

 l Missing. Segment   codes were exported, but the file (UnitSEQ#.SEG) is not in the import 
directory.

 l Aborted. The import was halted   before the procedure was complete.

 l Previously Imported. You cannot   import the same data twice.

Source   Codes

This column displays Yes if you included source codes as data to be exported when setting up the 
export process ID.  If you did not select source codes, this column displays N/A.

You can double-click the column to toggle between Yes and No. The column can display the 
following values:

 l No. Do   not import source codes.

 l Yes. Import   source codes.

 l N/A. Source   codes were not included in the data to be exported.

 l Missing. Source   codes were exported, but the file (UnitSEQ#.SRC) is not in the import 
directory.

 l Aborted. The import was halted   before the procedure was complete.

 l Previously Imported. You cannot   import the same data twice.

Transactions

This column displays Yes if you included transactions as data to be exported when setting up the 
export process ID.  If you did not select transactions, this column displays N/A.

You can double-click the column to toggle between Yes and No. The column can display the 
following values:

 l No. Do   not import transactions.

 l Yes. Import   transactions.

 l N/A. Transactions   were not included in the data to be exported.
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 l Missing. Not   in the import directory.

 l Aborted. The import was halted   before the procedure was complete.

 l Previously Imported. You cannot   import the same data twice.

Transaction   Optional Fields

This column displays Yes if you included transaction optional fields s as data to be exported when 
setting up the export process ID.  If you did not select transaction optional fields, this column displays 
N/A.

You can double-click the column to toggle between Yes and No. The column can display the 
following values:

 l No. Do   not import transaction optional fields.

 l Yes. Import   transaction optional fields.

 l N/A. Transaction   optional fields were not included in the data to be exported.

 l Missing. Transaction   optional fields were exported, but the file (UnitSEQ#.SRC) is   not in the 
import directory.

 l Aborted. The import was halted   before the procedure was complete.

 l Previously Imported. You cannot   import the same data twice.

Unit   ID

This column displays the unit ID for the set of import files.

Unit   Description

This column displays the  description entered for the unit ID on the G/L Consol Import Unit 
Maintenance screen.

Year

This column displays the fiscal year for the set of import files.

Reports Screens
Use the screens in the G/L Consol Reports folder to print reports of:

 l Information about the last import for each source company.

 l Mappings set up between source and destination accounts.
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 l Setup options for a specified export process.

 l Audit information for imports and exports.

Note: If the company does not maintain account groups, reports display N/A in the Account Group 
column.

G/L Consol. Export Audit Report

To Open this Screen

Open General Ledger > G/L Consolidations > G/L Consol. Reports > Export Audit.

Related Tasks

 l "Printing the G/L Consol. Export Audit Report" (page 40)

 l "Exporting General Ledger Data" (page 31)

 l "Selecting a Print Destination" (page 36)

 l "Selecting a Printer for Reports" (page 37)

Overview

The G/L Consol Export Audit report lists information on each export procedure you have run for one 
or more export processes.

When to Print

Print the report when you need to review export procedures you have run.

Information Printed on This Report

The following information is printed on the report:

 l The total number of budget export records

 l Number of records exported

 l Source and segment codes

 l Transaction number

 l Account group

 l Number of optional fields from C/S Setup or G/L Setup
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 l The mapping table and the mapping method (if used)

 l Currency information (for example, if destination currency is multicurrency)

Note: If you do not use Transaction Analysis and Optional Field Creator, reports display N/A   in the 
Optional Fields column.

Fields and Controls

Buttons

Close

Click Close to close the screen.

Print

Click Print to print the report.

Clear After Printing

Select this option to clear the specified range of data after printing.

Report By

Specify whether to print by process ID, date, fiscal period, or sequence number, and then specify a 
range of exports to include in the report.

Reprint Previously Printed

Select this option if items from the specified range have already been   printed and you would like to 
reprint them.

G/L Consol. Export Setup Report

To Open this Screen

Open General Ledger > G/L Consolidations > G/L Consol. Reports > Export Setup.
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Related Tasks

 l "Printing the G/L Consol. Export Setup Report" (page 39)

 l "Exporting General Ledger Data" (page 31)

 l "Selecting a Print Destination" (page 36)

 l "Selecting a Printer for Reports" (page 37)

Overview

The G/L Consol Export Setup report lists all the setup options used to define export processes.

The report displays the options that were chosen from the Main tab, the Transactions tab, the Criteria 
tab, the Currency tab, and the Mapping tab for a process ID.

Note: If you do not use Transaction Analysis and Optional Field Creator, reports display N/A   in the 
Optional Fields column.

G/L Consol. Import Audit Report

To Open this Screen

Open General Ledger > G/L Consolidations > G/L Consol. Reports > Import Audit.

Related Tasks

 l "Printing the G/L Consol. Import Audit Report" (page 41)

 l "Importing General Ledger Data" (page 32)

 l "Selecting a Print Destination" (page 36)

 l "Selecting a Printer for Reports" (page 37)

Overview

The G/L Consol Import Audit report lists information on every import procedure you have run.

When to Print

Print the report when you need to review import procedures you have run.
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Information Printed on This Report

The report lists information on import procedures you have run, including:

 l For each of the five budget sets, one of the following statuses:

 l Imported

 l Not Imported (but available)

 l Not Available

 l Missing

 l Aborted

 l Previously Imported

 l Method

 l Budgets

 l Import information such as:

 l Accounts

 l Source codes

 l Optional fields

 l Export information such as:

 l Currency

 l Date

You can specify the following criteria to sort and filter the contents of the report: 

 l Unit ID, Process   ID

 l Import Date

 l Unit ID, Fiscal   Period

 l Import Sequence   Number

Note: If you do not use Transaction Analysis and Optional Field Creator, reports display N/A   in the 
Optional Fields column.

Fields and Controls

Buttons

Close
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Click Close to close the screen.

Print

Click Print to print the report.

Clear After Printing

Select this option to clear the specified range of data after printing.

Report By

Specify how you want the   report ordered and the range of information to be printed. Options include:

 l Unit ID, Process   ID

 l Import Date

 l Unit ID, Fiscal   Period

 l Import Sequence   Number

Reprint Previously Printed

Select this option if items from the specified range have already been   printed and you would like to 
reprint them.

G/L Consol. Import Unit Maintenance Report

To Open this Screen

Open General Ledger > G/L Consolidations > G/L Consol. Reports > Import Unit Maintenance.

Related Tasks

 l "Printing the G/L Consol. Import Unit Maintenance Report" (page 38)                     

 l "Adding a Source Company ID for Importing" (page 21)

 l "Importing General Ledger Data" (page 32)

 l "Selecting a Print Destination" (page 36)

 l "Selecting a Printer for Reports" (page 37)
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Overview

The G/L Consol Import Unit Maintenance report lists the details of the last import from each source 
unit (company), in order of source currency. The report also displays the export method, and what 
was imported (for example, accounts, budgets, or optional tables).

Note: If you do not use Transaction Analysis and Optional Field Creator, reports display N/A   in the 
Optional Fields column.

G/L Consol. Mapping Table Report

To Open this Screen

Open General Ledger > G/L Consolidations > G/L Consol. Reports > Mapping Table.

Related Tasks

 l "Printing the G/L Consol. Mapping Table Report" (page 39)

 l "Setting Up a Mapping Table" (page 22)

 l "Selecting a Print Destination" (page 36)

 l "Selecting a Printer for Reports" (page 37)

Overview

The G/L Consol Mapping Table report shows how accounts are mapped from the source to the 
destination ledger for a range of mapping tables and account IDs. The report also includes the 
mapping method and segment substitutions.

Note: This report does not include optional field information. (All other G/L Consolidations reports 
include optional field data if you use Transaction Analysis and Optional Field Creator).

Setup Screens
Use G/L Consolidations Setup screens to:

 l Validate and manage import files from source companies.

 l Manage the mapping process of source company accounts to destination company accounts.

 l Create export processes to define the general ledger data to export.
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G/L Consol. Export Setup Screen

To Open this Screen

Open General Ledger > G/L Consolidations > G/L Consol. Setup > Export Setup.

Related Tasks

 l "Creating a Process ID to Specify General Ledger Data for Export" (page 24)

 l "Printing the G/L Consol. Export Setup Report" (page 39)

 l "Setting Up a Mapping Table" (page 22)

 l "Exporting General Ledger Data" (page 31)

 l "Consolidating General Ledger Data" (page 29)

Overview

Use the G/L Consol Export Setup screen to create process IDs that specify general ledger data to 
export from a source company.  For instructions, see "Creating a Process ID to Specify General 
Ledger Data for Export" (page 24).

Criteria Tab

If you selected Budgets on the Main tab, use the Criteria tab to specify the budgets to be exported.

Currency Tab

If  the   destination company is multicurrency, use the Currency   tab   to set up multicurrency options.

Main Tab

Use the Main tab to specify the unit ID of the source company from which you are exporting data,   and 
to select data to be exported.

Mapping Tab

Use the Mapping tab to specify whether   or not a mapping table is used for the export process, and to 
map General   Ledger account segments.
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Transactions Tab

If you selected   Transactions in the Data section on the Main tab, use the Transactions   tab   to select 
options specific to transactions.

Fields and Controls

Process ID

An export process specifies data to export and how it is to be exported. Enter a unique code of up to 
8 characters to identify the export process you are creating, or select an existing process ID to 
review or edit. 

Criteria Tab

Budget Information

If you selected budgets for export on the Main tab, select the budget sets (1 to 5) for exporting, and 
select the fiscal year containing the budget sets to be exported.

If you are using a mapping table to consolidate accounts (in other words,   if you are merging many 
source ledger accounts into one destination ledger   account), select the Consolidate option to 
consolidate the budgets for   all of the source accounts that are being merged.

 l If you select Consolidate, the relevant budget amounts will also be consolidated according to 
the mapping table. 

 l If you do not select Consolidate, only the budget for the last merged source ledger accounts 
will appear in the destination accounts.

Segment Information

If you want to restrict export data to accounts that have   a particular segment in the account number, 
or to a particular range of values   associated with that segment, select the Specify Segment Code 
for Export option, and specify a range of segment number values to include.

Note: If you select Specify Segment Code for Export, you must also select a balancing   account 
on the Main tab. For more information, see "About Specifying Account Segments for Export" 
(page 5).
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Currency Tab

Currency   Translation Accounts

These fields are available if you select the Translate to Different Functional Currency option.

Gains or losses   can occur on currency translation due to rounding and as a result of different   rates 
being applied on export. Any gains or losses   that arise from currency translation will be posted to the 
gain or loss   accounts specified here.

Default   Rate Type

These fields are available if you select the Multicurrency Destination Company option. You must 
select a rate type for the currency conversion.

 l If you are exporting   transactions and translating currencies, you must select a rate type for   
the currency conversion. Any   rate types specified for individual accounts in the mapping table 
for   the export process will override this default rate type.

 l If you are exporting   budgets and translating currencies, you must select a rate type for the   
currency translation. Although any   rate type specified in the mapping table will override the 
default rate   for transactions, this is not   the case with budgets. The rate type specified here will 
be used for all budgets.

Note: Any   system-generated entries made to the balancing account will use this default   rate type 
(for example, in the case of a partial export).

Multicurrency   Destination Company

Select this option if the destination company is multicurrency.

This option applies to the destination company only: it doesn’t matter whether   the source company 
is single currency or multicurrency, or whether the   source and destination companies have the 
same or different functional   currencies.

Translate   From

This option  appears if you are exporting detailed transactions by either fiscal period   or posting 
sequence from a multicurrency source company. It lets you translate   the individual source ledger 
transactions using either the functional   currency or the source currency of the individual 
transactions.

For example:
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 l A source company   has multicurrency activated and a functional currency of USD. 

 l Transactions   for posting sequence 200 had a source currency of GBP. 

 l The destination   company has a functional currency of CAD. 

You can choose to create transactions in the destination   company by converting the GBP amount 
(the original source currency amount)   or the USD equivalent (functional currency equivalent) to 
CAD.

This option does not apply to net account changes or balances because   these amounts are 
exported in functional currency only.

Translate   to Different Functional Currency

Select this option if the destination company has a different functional   currency from the source 
company. This will activate translations on export. 

Translation   Rate Date

After you specify the rate type, specify how exchange rates will be applied.

 l Fiscal   Period. The program will   base the exchange rates on the last day of the source 
(exporting) company's   fiscal period when the transaction occurred. 

Note: The fiscal period   used for the exchange rates is not affected by the offset. 

 l Transaction   Date. This option is available only if detailed transactions are   being exported 
(instead of balances or net changes). 

The exchange rate will be based on the rate in effect   on the actual dates of the original 
transactions in the source (exporting)   company.

 l Specified. If you select this option, you will be required to enter a rate   date at the time of 
export. 

In all cases, the actual rates are chosen from the exporting company.

Main Tab

Allow Runtime Edit

Select this option if you want to be able to clear data selections on the G/L Consol Export screen 
later.
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Note: Whether or not this option is selected, you cannot select new data for export on the G/L 
Consol Export screen.

Data

Account   Groups

Select this option to export account groups from the source company.

Note: When   importing an account group to the destination company, the account group   sort code 
will not be changed if the account group record already exists   in the destination company. In this 
situation, only the account group   description will change.

Account   Optional Fields

This option is available if you select Accounts as one of the   options to include in an export.

Accounts

Select this option to export account master   records (without balances).

Budgets

Select this option to export budgets. On the Criteria tab, you specify  budget sets to include, and you 
specify whether to consolidate   budget amounts that are mapped from several accounts to a single 
destination   account.

Note: You cannot use a period   offset when you export budgets.

Export   Inactive Accounts

Select this option to export inactive accounts. This option   is available if you select Accounts as one 
of the   options to include in an export. 

Optional   Fields from G/L Setup and CS Setup

Select this option to export optional fields   from G/L optional fields setup or from Common Services 
optional fields   setup. 
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You can export optional fields   even when they are not matched by optional fields in the destination 
company.

Segment   Codes

Select this option to export segment codes.

Set   Inactive Accounts To Active

If you are exporting inactive accounts, you can select this option to   set inactive accounts to active in 
the destination company. 

You might do this in a case where certain accounts are used only for posting by the   "holding" 
company. The integrity of these accounts in the source   ledger is assured by not allowing posting to 
these accounts in the normal   course.

Source   Codes

Select this option to export source codes.

Transactions

Select this option  to export transactions. On the Transactions tab, you specify whether to export 
account balances, net changes, or posted transactions by fiscal period   or by posting sequence.

Unit

Unit Balancing Account

A balancing account is used  in situations where   exported data is not balanced (such as when you 
export the net changes   for a partial chart of accounts). When setting up an export process, you 
must   select a balancing account when transactions are being exported under   the following 
conditions: 

 l When you select the Specify Segment Code for Export option on the Criteria   tab.

 l If you specify a   mapping table on the Mapping tab, and then select the Only   Transfer 
Mapped Accounts option.

 l If you   use source code exclusion.
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Unit ID

Enter the unit ID of the source company from which you are exporting data.

The unit ID forms the first four characters of the exported data file   names (for example, 
Unit0000.XXX),   and is used to identify and validate exported files upon import.

Before importing, you must use the G/L Consol Import Unit Maintenance screen to create a unit ID 
for the destination company. For more information, see "Adding a Source Company ID for 
Importing" (page 21).

Mapping Tab

Mapping   Method

When you set up a mapping table, select one of the following mapping methods:

 l Generate   An Error for Unmapped Accounts. G/L   Consolidations will generate an error for 
any general ledger accounts   that have not been specified in the selected mapping table. (In 
other   words, all accounts in the source company must be mapped if you select   this option; 
otherwise, exporting will generate errors.)

 l Only   Map Accounts in Table. If you select this option, you must map   the Unit Balancing 
account, the Transaction Balancing account, and the   Gain/Loss on Conversion account. If 
you did not map to these accounts   and if they had not been specified in the selected mapping 
table (and   if G/L Consolidations needs to create an entry to these accounts), you   will receive 
an error message.

 l Only   Transfer Mapped Accounts. If you select this option, only general   ledger accounts 
specified as source accounts in the mapping table will   be exported.

Mapping   Table

Specify a mapping table code to use   for this export process. For more information, see "Setting Up a 
Mapping Table" (page 22).

Segment   Number Substitution

If you are consolidating general ledger account segments, use this table to map   account segment 
numbers in the source company to different account segment   numbers in the destination company. 
For more information, see "About Segment Number Substitution" (page 6).
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Use   Mapping Table

Select this option if you want   to use a mapping table for the export process you are setting up.

Mapping tables are required only if you need to change account codes,   account segments, account 
structures, or rate types while exporting, or if you want to   merge account balances, net changes, or 
budgets while exporting.

You must also use a mapping table when you export account records   from a single currency 
company to a multicurrency company, or from a   multicurrency company to a single currency 
company.

Note: We strongly recommend   that both the exporting and importing companies use the same 
account   structure codes. If they do not, you should use the mapping table to map   all exported 
accounts.

Transactions Tab

Create   Zero Transactions

This   option is available if you select Net Changes or Balances as the export method. Select the 
option to produce a zero amount transaction for any accounts that   have a zero balance or a zero 
change in balance for the period. 

 l If you select this option, and users are exporting   transactions using net change or balances, 
the program exports all   transactions for the accounts selected (even for those accounts with 
$0   balance or $0 net change). This means that an export file with extension   of *.001 will be 
created even though the balance/net change for the account   is $0.

 l If you   do not select this option, export will not create transactions for zero   balances or net 
changes, so   no export file related to the transaction will be created.

Default   Source Code

Specify the general ledger source code that G/L Consolidations   will use as a default. We suggest 
that you create a different source code   for each source company.

Tip: Use two-character   unit IDs, with the   same two characters for the source code and for the unit 
ID that identifies   the source company.
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When you are consolidating several source companies, the source codes   can help you immediately 
identify the source company of each entry in   the destination ledger. For example, a source ledger   
and source code of GC-01 could identify all consolidation entries from   source unit 01.

Export Method

This field indicates the export method that will be used:

 l Balances. Exports   the balance of each account for the fiscal year and period that you select   
when you run the export process.

 l Net Changes. Exports the net change in the balance of each account for a fiscal year   and 
period that you select when you run the export process.

 l Transactions By Fiscal Period. Exports transaction for a fiscal year/period.

 l Transactions By Posting Sequence. Exports transactions for a range of posting sequences 
that you select   when you run the export process.

Insert   Original Audit Trail

This option appears if you select Transactions By Posting Sequence or Transactions By Fiscal 
Period as the export method. Select this option if you want to insert the original audit trail 
information   into the Comments field in each journal entry.

Maximum   Transactions Per Entry

This field appears if you select Transactions By Posting Sequence or Transactions By Fiscal 
Period as the export method.

You can use this field to limit the number of transaction details per   G/L entry. If you plan to review or 
edit batches in the destination   ledger, you may limit the maximum number of detail lines per entry. 
You   may also limit journal entry size to improve system performance (if you   are consolidating a 
large chart of accounts).

Note: If   this field is set to zero (0), all   transaction details will be exported into one journal entry.

Period   Offset

Specify a period offset to synchronize the source company's fiscal periods   with the destination 
company's periods, where they have different year-ends. 

 l If the periods in the   source and destination companies are the same, specify 0 as the period 
offset.
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 l If the source company's fiscal period ends before the destination company's, use a positive 
number. For example, if the source company has its year-end on March 31   and the 
destination company has its on December 31, specify 3 as the period offset. 

 l If the source company's fiscal period ends after the destination company's, use a negative 
number. For example, if the source company has its year-end on December 31   and the 
destination company has its on March 31, specify -3 as the period offset. 

Note: If you are using a period offset and currency translation rates are   based on the fiscal 
period, G/L Consolidations bases the exchange rate   on the source (exporting) company's period 
before the offset was applied.   Note that this date must be the   last day of the fiscal period.

Retain   Original G/L Reference

This option appears if you select Transactions By Posting Sequence or Transactions By Fiscal 
Period as the export method. 

Select it if you want the Reference field to contain the same   reference information that was posted 
in the original General Ledger entry.

Transaction Detail Description

This field appears if you select Net Changes or Balances as the export method. 

Enter a description for the transaction.

Transaction   Optional Fields

This option is available if you select Transactions By Posting Sequence or Transactions By 
Fiscal Period as the export method. 

Select it to include transaction optional fields.

Transaction   Source Ledger

Specify the transaction source ledger for each imported   journal entry. 

Tip: Create   a unique source ledger code for all data consolidated by G/L Consolidations,   to 
differentiate transactions from the normal general ledger transactions within   the destination 
ledger. For example, all consolidation entries could have a transaction source   ledger code of GC.
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Note: Because all transactions   within a general ledger batch must have the same transaction 
source ledger,   all transactions exported with this export process will use the transaction   source 
ledger specified here, irrespective of their source code in the   source company.

Transactions   Balancing Account

If you are limiting the number of transaction details per entry, specify an account to receive a 
balancing detail for the entry.

Source Code Conversions

This table appears if you select Transactions By Posting Sequence or Transactions By 
Fiscal Period as the export method. Use it to convert source codes during export.

Description

This   field displays the description of the selected source code.

Export Source Code

Specify  the source code to substitute for the original source code. 

Note: Only source codes for the source ledger specified on the Transaction tab   will be available.

Operation

Specify whether to exclude the source code or substitute a new code during export.

Original Source Code

Specify  the source code that will be substituted in the destination company.

G/L Consol.  Import Unit Maintenance Screen

To Open this Screen

Open General Ledger > G/L Consolidations > G/L Consol. Setup > Import Unit Maintenance.
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Related Tasks

 l "Adding a Source Company ID for Importing" (page 21)

 l "Printing the G/L Consol. Import Unit Maintenance Report" (page 38)

 l "Creating a Process ID to Specify General Ledger Data for Export" (page 24)

Overview

Use the G/L Consol Import Unit Maintenance screen to create and manage unit   IDs unique to each of 
a destination company's source companies, and to specify   and check the functional currency of the 
source company.

The unit ID, which is incorporated into the file names of the exported   data, identifies the data as being 
from the source company.  

Note: A destination company   cannot import any G/L data from a source company until a source 
unit ID has been   added on the G/L Consol Import Unit Maintenance screen that uniquely identifies 
the   source company. 

The screen displays   information relating to the last import performed from the source company.   For 
example, statuses of a previous import can be the following: 

 l Imported Successfully. Appears when a partial import has succeeded.

 l Not Available. You did not specify to import this information when setting up the export   in the 
source company, so no file was imported.

 l Missing. The file could not be found in the import directory.

 l Aborted. The import stopped before completion. Check for a restart record, correct   the error 
that caused the process to abort, and then retry the import.

 l Previously Imported. The file cannot be imported again.        

Fields and Controls

Description

Enter a description   for the source unit ID.

Functional   Currency

Specify the functional currency for the source unit ID. 
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Note: The destination company can import   general ledger data only if the functional currency 
specified here is the   same as that specified in the export from the source company.

Source   Unit ID

When setting up imports, you must specify a source unit ID  that exactly matches the unit ID you 
entered   on the G/L Consol Export Setup screen.

Last Import

Account   Groups

This field displays the status of account group information in the most recent import for the selected 
source unit ID.

Accounts

This field displays the status of account information in the most recent import for the selected source 
unit ID.

Budgets

This field displays the status of budget information in the most recent import for the selected source 
unit ID.

Export   Method

The field displays the export method used in the last import for the selected source unit ID.

First   Posting Sequence/Last Posting Sequence

These fields display the range of   posting sequences for the last import for the selected source unit 
ID (if Posting Sequence   was used as the basis for export).

Optional   Fields from CS / Optional Fields from G/L

These fields display the status of optional field information in the most recent import for the selected 
source unit ID.
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Segment   Codes

This field displays the status of segment code information in the most recent import for the selected 
source unit ID.

Source   Codes

This field displays the status of source code information in the most recent import for the selected 
source unit ID.

Transactions

This field displays the status of transaction information in the most recent import for the selected 
source unit ID.

Year/Period

This field displays the fiscal year and period  of the last import for the selected source unit ID (when 
the fiscal year or period was   used as the basis for the last export).

G/L Consol.  Mapping Table

To Open this Screen

Open General Ledger > G/L Consolidations > G/L Consol. Setup > Mapping Table.

Related Tasks

 l "Setting Up a Mapping Table" (page 22)

 l "Creating a Process ID to Specify General Ledger Data for Export" (page 24)

 l "Consolidating General Ledger Data" (page 29)

Overview

Use the G/L Consol Mapping Table screen to specify how individual   accounts can be consolidated, 
created or converted. 

Note: Using a mapping table   is optional in the G/L Consolidations process.
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You can use a mapping table to match source company   accounts to destination company accounts 
as follows:

 l Source company   accounts can be matched to destination company accounts on a one-to-one   
basis, where account numbers are dissimilar.

 l Source company   accounts can be matched to destination company accounts on a many-to-
one   basis, if you need to merge source accounts.

 l Source company   accounts and destination company accounts can have different consolidation   
options or different multicurrency settings.

 l The rate types   for individual accounts can be different from the default rate type (where   
translation occurs). 

For more information about consolidating information, see "About Consolidating Account Codes, 
Segment Codes, and Source Codes" (page 3).

For setup instructions, see "Setting Up a Mapping Table" (page 22).

Fields and Controls

Buttons

Validate

Click Validate to check that the source account numbers are   correct. Any invalid numbers will be 
deleted from the list.

Mapping Table

Select an existing mapping table, or enter a code to create a new mapping table.

Table

Closing   Segment

Enter the closing segment number for the target account. If you leave this field blank,   the program 
uses the closing segment of the source account.

Multicurrency

Specify whether you are exporting from a single currency company to a multicurrency company.
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 l Yes.   Select Yes if the destination account in the destination company is multicurrency,   and 
the account in the source ledger is single currency.

 l No.   Select No if the destination account in the destination company is single   currency, and 
multicurrency in the source ledger.

 l N/A.   Select N/A to use the setting of the source account in the source company.

Example: If the source ledger is set up as single   currency with a functional currency of USD, and 
the destination ledger   is set up as multicurrency with a functional currency of CAD, select Yes. 
Upon successful import in the destination   ledger, both the source currency (USD) and the 
functional currency (CAD)   will be displayed in the transaction exported to the destination ledger.

Notes: 
 l You can change   a single currency account to a multicurrency account.

 l You cannot   change a multicurrency account to a single currency account.

 l If you select Yes (that   is, a single currency account in the source   ledger becomes a 
multicurrency account in the target ledger), G/L Consolidations   assumes that all currencies 
are   valid for that account in the target ledger.

Posting   Type

Specify the type of posting to use:

 l Consolidate. Select   if the target account in the destination company is "consolidated."

 l Detail. Select if the   target account in the destination company is "detailed."

 l N/A. Select   to use the setting of the source account in the source company.

Rate   Type

If currency translation is relevant   for the consolidation process, use this field to specify a different   
rate type from the default rate type. 

This lets you ensure compliance with Generally Accepted   Accounting Principles when certain 
account balances need to be translated   using different rate types. For example, you may have to 
translate some account balances at spot   rates, others at average rates, and others at historic rates. 
All these   rate types can be set up and recorded in the mapping table to ensure consistent   
application of the different rate types.

G/L Consolidations uses the default rate type specified on the G/L Consol Export Setup screen for 
the export process.
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Rate   Type Description

This field displays the description of the rate type.

Source   Account

Specify the general ledger account number for the account in the source   ledger that you want to 
map.

Source   Account Description

The source account description is provided for information purposes   and cannot be changed.

Target   Account

Enter the account number for the account in the destination company   that you want to map to. If this 
field is empty, the program uses the source account number.

Target   Account Description

Enter a description for the target account. If this field is empty, the program uses the description   for 
the source account.

Target   Structure Code

Enter the general ledger account structure code for the target account.   If this field is empty, the 
program uses the general ledger account structure for   the source account.
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Appendix B: G/L Consolidations 
Security Authorizations

If security is turned on for your Sage 300 system, the system administrator must assign users security 
authorization for G/L Consolidations screens.

For information on turning on security, setting up security groups, and assigning authorizations, refer 
to the System Manager help.

Security 
Authorization

Description

Export Export general ledger data.                        

Export Setup Specify general ledger data to export from a source company.

Export Setup 
Inquiry

Create reports listing setup options used to define export processes.

Import Import files from a  source company to a destination company.

Import Unit 
Maintenance

Create and manage unit   IDs unique to each of a destination company's source 
companies, and specify   and check the functional currency of the source 
company.

Import Unit 
Maint. Inquiry

Create reports listing the details of the last import from each source unit, in order 
of source currency.

Mapping Table Specify how source company   accounts are matched to destination company 
accounts, which controls how   accounts can be consolidated, created, or 
converted.

Mapping Table 
Inquiry

Create reports showing how accounts are mapped from the source ledger to the 
destination ledger.

G/L Consolidations Security Authorizations
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Appendix C: Data Entry Tools, Tips, and 
Shortcuts

Use these tools and tips to speed up data entry in Sage 300.

Menu Commands
The following commands appear on the File, Settings (when available), and Help menus on Sage 300 
screens.

Note: Menu names and commands may differ by screen.

File Menu

Command Description Notes

Close Closes the current screen. You can also press Alt+F4 to close a screen.

Customize Lets you hide or display 
fields for users by UI Profile 
ID. 

Click File > Customize to hide fields on an open 
screen for users assigned to a UI Profile ID for that 
screen. 
When these fields are hidden, data that would 
normally appear in these fields cannot be printed.
For more information, see the help for the UI Profile 
Maintenance screen in the System Manager help.

Export Exports data records to 
other Sage 300 databases 
and non-Sage 300 
programs.

Click File > Export to export data. 
For example, you could export purchase statistics 
for use in spreadsheet or database software.

Note: You cannot export serial or lot numbers for 
kit components.

Import Imports data records from Click File > Import to import data.

File Menu Commands
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Command Description Notes

other databases and from 
non-Sage 300 programs. 

For example, you could use a spreadsheet to enter 
current requisitions         or purchase orders when setting 
up your system, and then import        the transactions 
later.

Note: You cannot import serial or lot numbers for 
kit components.

Print Prints the current report, 
list, or screen.

On screens with a corresponding report, click File > 
Print to open the report screen, which you use to 
select report options (if applicable) before printing 
the report.

Print Setup Selects a printer and sets 
printing options. 

Click File > Print Setup to set up your printer. You 
can select the default printer or select another from 
the list of installed printers.
For more information about print options, refer to 
your operating system documentation.

Save Saves the entries or 
changes you have made to 
the current screen.

If you have just entered a new record, Add appears 
instead of Save.

Settings Menu

Command Description Notes

Auto Clear Creates a new entry 
automatically when you 
post a transaction. 

Use the Auto Clear option to streamline data 
entry in transaction entry screens.

 l If Auto Clear is turned on, all fields are 
cleared each time you post a transaction, 
allowing you to immediately begin 
entering another transaction. 

 l If Auto Clear is turned off, transaction 
information remains on the screen after 
you post it. Click the New button to begin 
entering another transaction. 

Clear Saved Restores default settings This command is available for screens and for 

Settings Menu Commands
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Command Description Notes

Settings for a report. some reports.

Save Settings as 
Defaults

Saves the current report 
settings as personal 
defaults.

This command is available for screens and for 
some reports.

Help Menu

Command Description

About Displays version and copyright information for the current screen and program.

Contents Opens Help.

Using Help Opens Help to an introductory topic on how to use Help.

Help Menu Commands

Data Entry Tools and Shortcuts
Use these tools and shortcuts to speed up data entry in Sage 300.

Tool Shortcut 
Key

Description

 Alt + A Add or save a new record.

Calendar F4 
or 
Alt + Down 
Arrow

Display the calendar for a date field.

 Alt + C 
or 
Alt + F4

Close a screen or dialog box

 Del or 
Alt + D

Delete the selected row or record.

Data Entry Tools and Shortcuts

81Sage 300 2022 G/L Consolidations User's Guide



Tool Shortcut 
Key

Description

Drilldown n/a The Drilldown  button appears beside some data entry fields and 

in some column headings in transaction detail entry tables. Click it 
to view details of the record or transaction in the corresponding 
field. Mo re ...

You can "drill down" both within Sage 300 programs and between 
separate programs. For example, you can drill down:

 l From General Ledger transactions to original transaction 
entries.

 l From Accounts Receivable to Order Entry.

 l From Accounts Payable to Purchase Orders.

 l From one transaction to an originating transaction (such as 
from a credit note to the invoice) within a program.

 Alt + E Open the Set Criteria dialog box to filter the list of records to display 
in the Finder.

Finder F5 The Finder  appears in some data entry fields, and in some table 

headings in transaction entry screens. Click it when you want to look 
up records you can select for a field. Mo re ...
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Tool Shortcut 
Key

Description

Use the Finder to search lists of codes maintained in         or used by 
Sage 300 programs (such as document numbers, terms codes, and 
account set codes). You can use menu commands in the Finder to 
help you search, as follows:

 l On the Settings menu, select  Color options to          highlight a field 
using color for the text or for the background.

 l On the Settings menu, select Field Name as Column           
Heading to use field descriptions or internal field names          as 
column headings.

 l On the Settings menu, use Columns options to specify 
columns that appear in the table. 

 l On the Global Settings menu, select the Go to Filter First 
option if you want the Finder to display the same filter settings 
you specified on the Find By list the next time you search this 
type of record.

You can also use the Auto Search option to locate a record quickly          
in a long list. To do this, select Auto Search and the criteria by 
which          you want to search, and then begin typing the characters that 
start or are contained         in the field you are searching on.

Note: Records that appear in the Finder are restricted by          any 
selection criteria          you apply to this field.  If you cannot find the 
record you are          looking for with the Finder or the navigation 
buttons, check the Finder          to see whether any criteria are being 
used to limit the selection. If         necessary, remove the selection 
criteria. (For more information, see "Setting Finder Criteria" 
(page 87))

Tip: For additional instructions on using the Finder to select 
records, press F1 when the Finder screen appears.

Go F7 The Go  button appears on screens where you must enter 

information (such as filter criteria) before viewing records that 
match the information you enter. Mo re ...

For example, on some Statistics and Inquiries screens, you must 
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Tool Shortcut 
Key

Description

select a range of years and periods and specify an item number or 
vendor number before you can view statistics. (If you use 
multicurrency accounting, you must also specify a currency.) After 
specifying this information, you click the Go  button or press F7 to 

view statistics.

Navigation n/a Click the Previous and Next buttons to navigate through a list of 
existing records, or click the First and Last buttons to navigate to the 
first and last records. Mo re ...

Note: If you clicked the Set Criteria button on the Finder screen 
and specified criteria, only records that match the criteria you 
specified will appear when you use the navigation buttons. If a 
record does not appear, click the Finder  and check to see 

whether you have specified criteria that prevent the record from 
appearing.

New n/a Click the New  button or select New from a menu to begin 

creating a new record.

 Alt + S Save changes to the displayed record.

Zoom F9 Click the Zoom  button  or press the F9 key to view or enter 

supplementary information        for a transaction detail or for a field. Mo re ...
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Tool Shortcut 
Key

Description

In any detail entry table, you can select a detail line and press F9 to 
open a screen that displays all the fields for a single detail,          including 
additional tax-related fields that do not appear on the detail          table. 
You can edit existing details, and even add new details for         the 
document.
Beside any field that displays a Zoom button, you can click the 
button (         or select the field and then press F9) to open          a separate 
screen where you can view and enter supplementary information 
specific         to that field. 

Note: If another Zoom button appears on the detail screen, you 
can click it or press Shift+F9 to open the new detail screen. (If you 
simply press F9 again, the first detail screen closes.) This 
function is referred to as "Detail Zoom." To close the second 
detail screen, press Shift+F9 again.

After viewing or editing the information in the detail screen, you can 
press F9 to close the screen.

Working with Detail Entry Tables
The first tab of each transaction entry screen in Sage 300 contains    a detail entry table that shows the 
document details in tabular format.

In most cases, you can enter all the necessary details for a document    right on the table.

Tip: If there are more columns than can be displayed at one time, you can     use the horizontal scroll 
bar at the bottom of a list to view the additional     columns. You can also rearrange the order of 
columns, or change column    widths, consistent with how you enter data. 

You can also view and edit all the fields for a single detail on a separate    Detail Items/Taxes screen. To 
view this screen, select a detail line and click the Item/Tax button below the table, or press F9. 

Note: You use the Detail Items/Taxes screen to view or change tax    information for a detail. Detail 
tax fields do not appear in the detail table.
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To add details using the detail table, do one of the following:

 l If a blank line is highlighted,      tab to the Item Number field, then either type the item number or 
select     it from the Finder. Enter the remaining information for the detail.

 l To start a new line, press      Insert or tab through the end of the last line on the table. 

If you want       to insert a new line in a specific location, highlight the line above     the location, and 
then press Insert.

Note: A detail line is saved as you enter it on the detail entry table. 

To edit details using the detail table: 

 l Select the line you     want to edit, and then enter your changes on that line.

Note: For information about using your keyboard to move within a detail table, see "Keyboard 
Shortcuts for Detail Tables" (page 86)

To delete details using the detail table: 

 1. Select the line you     want to delete.

 2. Press the Delete key on     your keyboard.

 3. If you see a message asking     you to confirm the deletion, click Yes.

To edit item information or detail tax information using the Detail Items/Taxes screen:

 1. Select the detail on the table, and  then either click the Item/Tax button, or press F9.

 2. Edit the item information and/or change     the Tax Class or Tax Included options for the detail.

Keyboard Shortcuts for Detail Tables
Use the following keyboard shortcuts to navigate in detail tables.

Key Menu Command Action

Ins/Insert New Insert a blank row to add a new record.

Del/Delete Delete Remove the selected row.

Up or Down Arrow  Go up or down one row.

Keyboard Shortcuts for Detail Tables
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Key Menu Command Action

Left or Right Arrow  Go left or right one column.

Pg        Up  Go to the top row in view.

Pg Dn  Go to the bottom row in view.

Home First Go to the first row in a list.

End Last Go to the last row in a list.

Tab or Enter; 
Shift+Tab        or 
Shift+Enter

 Go to the next or previous column in a list.

Setting Finder Criteria
To help you search quickly through a long list of records, you can use criteria to restrict the records 
that are displayed in the Finder and when    you use the navigation buttons. 

However, at other times, if the Finder uses criteria, it    might not display all the records you expect to 
see.

To check or remove the criteria:

 1. Click the Finder .

 2. Click the Set Criteria button.

 3. On the screen that appears, click the Clear button.

For instructions on setting criteria, click the Help button when the    Set Criteria screen appears.
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Appendix D: Support and Resources

Find support and resources to help get Sage 300 up and running quickly.

Finding Help and Documentation
You can find information about setting up and using Sage 300 in the Sage 300 help and in the product 
documentation included with this release.

Note: For technical support, visit our customer support website at https://support.na.sage.com or 
contact your Sage business partner.

Context-Sensitive Help

Sage 300 features context-sensitive help that you can use to quickly open and view articles and 
information directly from Sage 300 screens.

 l On the Sage 300 Desktop, press F1 to view help for the current screen.

 l On Sage 300 Web Screens, click the help menu at the top of the screen to see help articles and 
resources related to your current task.

Product Documentation

Sage 300 includes guides in printable PDF format, including the Installation and Administration 
Guide, Upgrade Guide, and other documentation related to installation and setup.

These guides are available in the Docs folder on the Sage 300 server, and online at:

 l https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.

To view the guides in the Docs folder:

 l On the Windows taskbar, click Start > Programs > Sage 300 > Documentation.

Support and Resources
Use the links below to find instructions,   software training, one-on-one support, technical 
specifications, or other   resources to get Sage 300 working smoothly for your business.
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Your Sage Business Partner is also an excellent resource to consult when you have questions about 
Sage 300.

How can we help you?

I'm setting up Sage 300 and need information or assistance

 l Sage 300 Resources online — 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm

Find and download user guides, technical specifications, and more.

 l Sage 300 Web Portal — www.sage.com/us/erp/sage-300

Find a business partner, get priority support, and more.

I'm looking for instructions to complete a task in Sage 300

While using Sage 300, you can get instructions directly from the software in the following ways:

 l Contextual Help  — To see topics related to your current task:

 l In the Sage 300 Desktop, press F1.

 l In Sage 300 Web Screens, click the help menu at the top of the screen.

 l Help Topics — To explore topics and information in the Sage 300 Desktop, click Help > Help 
Topics.

I think something is broken, or I'm getting error messages                 

Search our knowledge base for solutions to common issues, or contact us for one-on-one 
assistance.

 l Knowledge Base — https://support.na.sage.com

Find answers and solutions to FAQs and known software issues.

 l Customer Center — https://customers.sagenorthamerica.com/irj/portal/anonymous/login

Exclusive support for Sage customers.

 l Partner Center — https://partners.sagenorthamerica.com

Exclusive support for Sage partners.
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I'm looking for downloads, updates, or technical specifications                 

Find product updates, download resources, or review technical specifications for Sage 300.

 l Sage 300 Resources online — 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm

Find and download user guides, technical specifications, and more.

 l Sage Business Care — www.sage.com/us/erp/sage-business-care

Find links to support services, contact our support team, and learn how to guarantee your 
Sage software is always up to date.

I want to become a more skilled user of Sage 300

Find links to Sage software training, online communities, and more.

 l Sage University — https://sageu.csod.com/LMS/catalog/Welcome.aspx?tab_page_id=-67

Convenient, professional training options to help you achieve your business goals.

 l Sage Summit — www.sage.com/sage-summit

Connect with peers and experts at our annual conference.

 l Priority Software Support — www.sage.com/us/erp/sage-business-care

Learn how to get unlimited support by phone, e-mail, and live chat.

I want to share knowledge with other Sage 300 users                 

Find and share tips, tricks, and solutions online in the Sage 300 Community.

 l Sage 300 Community — http://sagecity.na.sage.com/support_communities/sage300_erp

Explore Sage 300 blogs, discussions, FAQs, resources, and more. 

 l Sage Summit — www.sage.com/sage-summit

Connect with peers and experts at our annual conference.
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I want to contact a Sage 300 representative                 

 l Support and Services — http://support.na.sage.com

Find links to support services, contact our support team, and learn how to guarantee your 
Sage software is always up to date.

92Sage 300 2022 G/L Consolidations User's Guide

http://support.na.sage.com/


A

account code structures  9, 59

archiving files  30

audit trails  11, 18, 59

original G/L references  60

B

budgets  7

buttons

Drilldown  82

Finder  82

Go  83

Navigation  84

New  84

Zoom  84

C

commands  81

Consolidate option  8

Consolidation screens

Export  43

Import  45

currency translation rates  17

D

data entry screens  86

detail entry tables  85

details

adding  86

deleting  86

editing  86

documentation and help  89

Drilldown button  82

E

e-mail

printing reports as attachments to  36

exchange losses  13

exchange rates  13, 17

Export Audit report  53

fields and controls  54

printing  40

Export screen  43

fields and controls  44

export sequence numbers  30

Export Setup report  54

printing  39

Index

93Sage 300 2022 G/L Consolidations User's Guide



Export Setup screen  59

fields and controls  60

exported files  30

exporting data  24

partial exports  11

F

File menu commands  79

Close  79

Customize  79

Export  79

Import  79

Print  80

Print Setup  80

Save  80

Finder button  82

setting criteria  87

function keys  81

G

G/L (general ledger)

audit trails, references for  9

consolidating data  29

exporting data  24, 31, 59

importing data  32

GAAP (generally accepted accounting 
principles)  13

Go button  83

guides and documentation  89

H

Help menu  81

I

icons  81

Import Audit report  55

fields and controls  56

printing  41

Import screen  45

fields and controls  46

Import Unit Maintenance report  57

printing  38

Import Unit Maintenance screen  69

fields and controls  70

importing data

problems  34

troubleshooting  34

Installation and Administration Guide  89

installing Sage 300, documentation on  89

J

journal entry fields  18

K

keyboard shortcuts

for detail tables  86

keys  81

94Sage 300 2022 G/L Consolidations User's Guide



M

Mapping Table report  58

printing  39

Mapping Table screen  72

fields and controls  73

mapping tables  3, 15

setting up  22

menus and commands  79, 81

File  79

Help  81

Settings  80

multilevel consolidations  12

N

Navigation buttons  84

New button  84

O

options

for printing reports  35

P

partial exports  11

print destinations  36

e-mail attachment  36

file  36

physical printer  36

preview (on screen)  36

printer

assigning to a specific report  37

printer, physical

setting as print destination  36

printing reports  37

options  35

process IDs  24

R

reports  35

print destinations  36-37

printing options  35

Reports screens

Export Audit  53

Export Setup  54

Import Audit  55

Import Unit Maintenance  57

Mapping Table  58

rounding differences  13

S

screen guides  43

security authorizations  77

segment numbers, substituting  6

Settings menu commands  80

Auto Clear  80

Clear Saved Settings  80

95Sage 300 2022 G/L Consolidations User's Guide



Save Settings as Defaults  81

Setup screens

Export Setup  59

Import Unit Maintenance  69

Mapping Table  72

shortcuts  81

source codes for transactions  60

T

technical support  89

tools  81

transactions, consolidating  9

translation rates, for currency exchange  17

U

unit balancing accounts  11

unit IDs  70

Upgrade Guide  89

Z

Zoom button  84

96Sage 300 2022 G/L Consolidations User's Guide


	Introduction
	Chapter 1: Key Concepts in G/L Consolidations
	About Consolidating Account Codes, Segment Codes, and Source Codes
	About Consolidating Budgets
	About Consolidating Transactions
	About Currency Translation
	About Period Offset for Differing Fiscal Periods
	About Audit Trails

	Chapter 2: Setting Up G/L Consolidations
	Adding a Source Company ID for Importing
	Setting Up a Mapping Table
	Creating a Process ID to Specify General Ledger Data for Export

	Chapter 3: Consolidating General Ledger Data
	About Exported Files
	Exporting General Ledger Data
	Importing General Ledger Data
	About Import Problems
	Troubleshooting Import Problems

	Chapter 4: Printing G/L Consolidations Reports
	Printing Tips
	Printing the G/L Consol. Import Unit Maintenance Report
	Printing the G/L Consol. Export Setup Report
	Printing the G/L Consol. Mapping Table Report
	Printing the G/L Consol. Export Audit Report
	Printing the G/L Consol. Import Audit Report

	Appendix A: G/L Consolidations Screen Guides
	Consolidations Screens
	Reports Screens
	Setup Screens

	Appendix B: G/L Consolidations Security Authorizations
	Appendix C: Data Entry Tools, Tips, and Shortcuts
	Menu Commands
	Data Entry Tools and Shortcuts
	Working with Detail Entry Tables
	Keyboard Shortcuts for Detail Tables
	Setting Finder Criteria

	Appendix D: Support and Resources
	Finding Help and Documentation
	Support and Resources

	Index

